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Notice
Every effort was made to ensure that the information in this document was accurate at 
the time of printing. However, information is subject to change without notice, and Viavi 
reserves the right to provide an addendum to this document with information not avail-
able at the time that this document was created.

Copyright 
© Copyright 2018 Viavi, LLC. All rights reserved. Viavi, Enabling Broadband and Optical 
Innovation, and its logo are trademarks of Viavi, LLC. All other trademarks and regis-
tered trademarks are the property of their respective owners. No part of this guide may 
be reproduced or transmitted electronically or otherwise without written permission of 
the publisher.

Trademarks
Viavi and 4000 V2 Platform are trademarks or registered trademarks of Viavi in the 
United States and/or other countries.

Microsoft, Windows, Windows CE, Windows NT, and Microsoft Internet Explorer are 
either trademarks or registered trademarks of Microsoft Corporation in the United States 
and/or other countries.

Netscape Navigator is a trademark or registered trademark  of Netscape Communica-
tions Corporation in the United States and other countries.

Ordering information
This guide is a product of Viavi's Technical Information Development Department, issued 
as part of the User Manual.

WEEE Directive Compliance
Viavi has established processes in compliance with the Waste Electrical and Electronic 
Equipment (WEEE) Directive, 2002/96/EC, and the Battery Directive, 2006/66/EC.
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This product, and the batteries used to power the product, should not be disposed of as 
unsorted municipal waste and should be collected separately and disposed of according 
to your national regulations. In the European Union, all equipment and batteries 
purchased from Viavi after 2005-08-13 can be returned for disposal at the end of its 
useful life. Viavi will ensure that all waste equipment and batteries returned are reused, 
recycled, or disposed of in an environmentally friendly manner, and in compliance with 
all applicable national and international waste legislation.

It is the responsibility of the equipment owner to return equipment and batteries to Viavi 
for appropriate disposal. If the equipment or battery was imported by a reseller whose 
name or logo is marked on the equipment or battery, then the owner should return the 
equipment or battery directly to the reseller.

Instructions for returning waste equipment and batteries to Viavi can be found in the 
Environmental section of Viavi’s web site at www.viavisolutions.com. If you have ques-
tions concerning disposal of your equipment or batteries, contact Viavi’s WEEE Program 
Management team.
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About This Guide

The 4000 V2 Platform of Viavi provides a portable, modular platform designed for the 
installation, turn-up and maintenance of fiber optic networks.

The topics discussed in this chapter are as follows:

• “Purpose and scope” on page xvi

• “Assumptions” on page xvi

• “Technical assistance” on page xvi

• “Recycling Information” on page xvi

• “Conventions” on page xvii
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Purpose and scope
The purpose of this guide is to help you successfully use the 4000 V2 Platform features 
and capabilities. This guide includes task-based instructions that describe how to install, 
configure, use, and troubleshoot the 4000 V2 Platform. 

Additionally, this guide provides a complete description of Viavi’s warranty, services, and 
repair information, including terms and conditions of the licensing agreement.

Assumptions
This guide is intended for novice, intermediate, and experienced users who want to use 
the 4000 V2 Platform effectively and efficiently. We are assuming that you have basic 
computer and mouse/track ball experience and are familiar with basic telecommunica-
tion concepts and terminology.

Technical assistance 
If you require technical assistance, call 1-844-GO-VIAVI. For the latest TAC information, 
go to http://www.viavisolutions.com/en/services-and-support/support/technical-assis-
tance.

Recycling Information
Viavi recommends that customers dispose of their instruments and peripherals in an 
environnmentally sound manner. Potential methods include reuse of parts or whole 
products and recycling of products components, and/or materials.

Waste Electrical and electronic Equipment (WEEE) Directive

In the European Union, this label indicates that this product should not be 
disposed of with household waste. Il should be deposited at an appropriate 
facility to enable recovery and recycling.

http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
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Conventions
This guide uses naming conventions and symbols, as described in the following tables.

Table 1 Typographical conventions

Description Example

User interface actions appear in this 
typeface.

On the Status bar, click Start.

Buttons or switches that you press on a 
unit appear in this TYPEFACE.

Press the ON switch

Code and output messages appear in 
this typeface.

All results okay

Text you must type exactly as shown 
appears in this typeface.

Type: a:\set.exe in the dialog box

Variables appear in this typeface. Type the new hostname.

Book references appear in this typeface Refer to Newton’s Telecom Dictionary

A vertical bar | means “or”: only one 
option can appear in a single command.

platform [a|b|e]

Square brackets [ ] indicate an optional 
argument.

login [platform name]

Slanted brackets < > group required 
arguments.

<password>

Table 2 Keyboard and menu conventions 

Description Example

A plus sign +  indicates simultaneous keystrokes. Press Ctrl+s

A comma indicates consecutive key strokes. Press Alt+f,s

A slanted bracket indicates choosing a submenu from 
menu.

On the menu bar, click Start > 
Program Files.
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Table 3 Symbol conventions

Table 4 Safety definitions

This symbol represents a general hazard.

This symbol represents a risk of electrical shock.

NOTE

This symbol represents a Note indicating related information or tip.

This symbol, located on the equipment or its packaging indicates that 
the equipment must not be disposed of in a land-fill site or as munici-
pal waste, and should be disposed of according to your national regu-
lations.

WARNING

Indicates a potentially hazardous situation which, if not avoided, could result 
in death or serious injury.

CAUTION

Indicates a potentially hazardous situation which, if not avoided, may result 
in minor or moderate injury.
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Chapter 1Safety information

This chapter gives the main information on the safety conditions when using the 4000 
V2 Platform

• “AC/DC and battery important safety instructions” on page 2

• “Precautions relating to optical connections” on page 3

• “Laser safety” on page 3



Chapter 1 Safety information
AC/DC and battery important safety instructions

2 User Manual 74000NG012 Rev. 000

AC/DC and battery important safety instructions

The 4000 V2 Platform is supplied with a Lithium Ion rechargeable battery.

• Batteries supplied by Viavi incorporate protection means.

If another adapter or battery is used, it may damage the 4000 V2 Platform itself. Using 
the product with batteries other than those supplied by the manufacturer of the 4000 V2 
Platform may entail risks of fire or explosion. 

– The battery may explode, leak or catch fire:
- if it is exposed to high temperature or fire
- if it is opened or dismantled.

• The Lithium Ion battery is designed for maximum safety. In particular, each cell is 
provided with a safety valve to prevent excessive internal pressure in the event of 
overcharging or exposure to very high temperatures.

• If you do not intend to use the platform for several weeks, it is advisable to 
remove the battery in order to prolong its useful life, and to recharge it fully before 
using it again.

• In case of communication problems with the battery, informed to the user, the 
battery charging information is no more actualized.
Restart the equipment to restore the communication with battery.

Other basic safety precautions are as follows:

• Do not use AC/Adapter/Charger outdoors or in wet or damp locations

• Connect the AC/Adapter/Charger to the correct mains voltage, as indicated on 
the ratings label.

• This product is intended to be used with a 3-wire grounding-type plug (a plug that 
has a grounding pin). This safety feature is vital to the safe operation of the instru-
ment. Do not defeat the purpose of the grounding-type by modifying the plug or 
using an adapter.

In conformance with the recommendations of standard EN 61010, the 
instrument should be operated within the manufacturer’s guidelines. Failure 
to do so may compromise the protection offered by the instruments design.

Do not use any mains adapter or battery other than those supplied with the 
instrument, or supplied by Viavi as an option for this instrument.
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• Do not allow anything to rest on the power cord, and do not locate the product 
where people can walk on the power cord.

• Avoid using this product during an electrical storm. There may be a remote risk of 
electric chock from lightning.

• Do not use this product in the vicinity of a gas leak or in any explosive environ-
ment.

• Do not attempt to service this product yourself, as opening or removing covers 
may expose you to dangerous, high voltage points and other hazards. Contact 
qualified service personnel for all service.

Precautions relating to optical connections
• The normal operating life of an optical connector is usually of the order of a few 

hundred manipulations. It is then advisable to manipulate the optical connections 
of the Platform as rarely as possible.

• The proper operation of the instrument and its accuracy of measurement are 
dependent on the cleanliness of the environment and the optical connectors as 
well as the care taken in its manipulation.

• The optical connectors must therefore be clean and dust-free. If the optical 
connection is not being used, protect the connections of 4000 V2 Platform using 
the protective caps.

As an example, the results of measurements made with connectors that have not been 
cleaned will display an error of the order of 10% for all measurements. This error is addi-
tional to other errors inherent in the measurement process and due, for example, to the 
quality of the fiber (circularity and concentricity), the means of connection (axis align-
ment, distance between fiber faces, quality of fiber faces) and propagation modes.

Laser safety
The provisions contained in two standards define the safety procedures to be observed 
both by users and by manufacturers when utilizing laser products:

• EN 60825-1: 2001 - Safety of laser products – Part 1: Classification of products, 
requirements and user guidelines. 

• FDA 21 CFR § 1040.10 - Performance standards for light-emitting products - 
Laser products.

Due to the range of possible wavelengths, power values and injection characteristics of 
a laser beam, the risks inherent in its usage vary. The laser classes form groups repre-
senting different safety thresholds.



Chapter 1 Safety information
Laser safety

4 User Manual 74000NG012 Rev. 000

Laser classes
Standards EN 60825-1, Edition 1.2, 2001-08 and FDA21CFR§1040.10: 

• VFL option: Class 2

Warning labels for the laser classes 
Due to the reduced dimensions of the optical modules, it is not possible to attach the 
required warning labels to them. In line with the provisions of Article 5.1 of the EN 60825-
1 standard, the laser class identification labels are shown below:

The user must take the necessary precautions concerning the optical output of the 
instrument and follow the manufacturer’s instructions.

Reference standard EN 60825-1, Edition 1.2, 2001- 08 FDA21CFR§1040.10

Class 1

Class 2

CLASS 1
LASER PRODUCT

Measurements on optical fibers are difficult to execute and the precision of 
the results obtained depends largely on the precautions taken by the user.
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Chapter 24000 V2 Platform Overview

This chapter provides a general description of the 4000 V2 Platform.

Topics discussed in this chapter include the following: 

• “Unpacking the instrument” on page 6

• “About the 4000 V2 Platform” on page 6

• “Main features” on page 7

• “Hard keys and Indicators” on page 9

• “Power Supply” on page 11
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Unpacking the instrument
1 Remove the 4000 V2 Platform and its accessories from the packing case.

2 Check that the module and accessories ordered are all there.

If any part is missing or damaged please contact your local Viavi agent.

The 4000 V2 Platform is delivered as standard with:

About the 4000 V2 Platform
The architecture of the 4000 V2 Platform is made of one Platform, to which one or two 
modules can be added to perform tests on fiber networks.

The modules that can be fitted to the 4000 V2 Platform are interchangeable in the field 
and different kinds of module are usable:

• OTDR Modules

• CWDM Analyzer Modules (C-OSA)

The 4000 V2 Platform employs multi-tasking for the simultaneous performance of 
several operations:

• acquisitions

• modifications of parameters

• trace analysis

• report management

It also allows to use simultaneously several functions:

• Power Meter

• Scope

• OTDR measurements...

Table 1 Elements delivered on standard with the 4000 V2 Platform

A Getting Started Manual

A Li-Polymer battery, set into the equipment and which must be charged before use

A mains adapter with one power cord for a given country (configured at the time of 
order) 



Chapter 2 4000 V2 Platform Overview
Main features

User Manual 74000NG012 Rev. 000 7

Main features
The 4000 V2 Platform is equipped with the following elements:

• A 9 inches TFT color touchscreen, high visibility

• RJ45 plug for Ethernet interface

• Two USB 2.0 host connectors for Microscope, USB memory stick, mouse, 
keyboard...

• An audio jack to connect a headset

• A connection socket for the mains adapter providing the 12 V power supply and 
used to charge the battery.

• LED indicators for Charge, On status and Test

• A Li-Polymer battery

• A module interchangeable in the field: OTDR, or C-OSA.

• Built-in Power Meter, VFL and/or Talkset (options)

With the 4000 V2 Platform, the user can:

• Open and/or transfer files to a PC via a USB memory stick, USB cable or Blue-
tooth (option)

• Generate pdf reports

• Open all user documentations included into the 4000 V2 Platform

• Update the 4000 V2 Platform firmware

• Remote the screen of the 4000 V2 Platform onto a PC and issue commands from 
the keyboard of the PC

• ...

Fig. 1 4000 V2 Platform and module(s)

T-BERD/MTS 4000 V2 
(two modules)

T-BERD/MTS 4000 V2 
(one module)
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Fig. 2 4000 V2 Platform: Front view

Hard key

Indicators

TFT 9’’ Color 
Touchscreen

Tactile keys

Indicators

Fig. 3 4000 V2 Platform: Connectors View

USB hostVFL Talkset AC/DC InputRJ45
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Hard keys and Indicators

Front panel tactile and hard keys

Hard key Function

Main on/off switch

Tactile keys

The Home tactile key gives access to:

• selection of the different measurement or functions

• the settings of the instrument

• the help page

This button calls up the Results/Setup/File page: click once and 
select the page wished from the list: 

• In the file page, you can choose the storage medium 
(internal memory, USB key) and manage files; with facili-
ties for classifying them in directories and sub-directories.

• In the Setup page, you can configure the measurement . 
This menu depends on the function in use.

• In the Results page, you can display the results page of the selected 
function (e.g. with OTDR module: reflectometry trace and table).

Starts and stops the measurement.

Direction keys used to navigate on screen:
– on the Results page, they are used to move the cursors or modify the 

zoom factor.
– on the set-up pages, they are used to scroll through the menus, the cen-

tral button serving to select or confirm the parameter chosen.

Validation/Enter key
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The 6 buttons are available clicking on the upper banner of the screen. 

A key Export is also available, allowing to generate a screenshot of the current dis-
played screen, in pdf,. It is saved in the directory Report, created automatically at 
screenshot generation.

Front panel indicators
The 4000 V2 Platform is equipped with three indicators, lit into a different color according 
to the status of the unit.

NOTE

All these functions, except HOME, depend on the modules used and the 
measurements made: refer to the user manuals of the corresponding mod-
ules of the 4000 V2 Platform.

Figure 4 Buttons on the upper banner

Table 2 Indicators Status

On indicator

 Blinking green The instrument, though connected to an external power source, is 
switched off.

Solid green The instrument is operating, either by battery or on an external 
power supply.

Charge indicator

Solid green The instrument is connected to an external power source and the 
battery is fully charged.

Solid red The instrument is connected to an external power source, and the 
battery is on charge.

Testing indicator
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Power Supply
The 4000 V2 Platform may operate with

• the Li-Polymer battery, already set into the equipment on delivery.

• an AC adapter/charger, via a power cable on which has been set the correct 
country adaptable plug.

Solid red At least one function is in measurement phase (for example, the 
laser emission pilot for an OTDR measurement)

Table 2 Indicators Status

Fig. 5 Delivered elements for 4000 V2 Platform supplying

Interchangeable plugs

UK adaptable plug 
(installed by default)

EUROPE 
adaptable plug

US
adaptable plug

JAPAN
adaptable plug

AUSTRALIA
adaptable plug

Power supply plug
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Chapter 3Starting up

This chapter explains the operations to be carried out before using the 4000 V2 Platform.

The topics discussed in this chapter are as follows:

• “Fitting and removing a module” on page 14

• “Setting the 4000 V2 Platform into the glove” on page 15

• “Charging the battery” on page 16

• “Switching the 4000 V2 Platform on and off” on page 18

• “First start: configuring your regional settings” on page 19
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Fitting and removing a module

Fitting a module
• Turn the instrument face down on the work surface.

• Set the two notches on the module part (1a) into the two holes provided for that 
purpose on the Base (1b).

• Make flush the 2 connections (2a & 2b), on module and base.

• Once positioned, fix the module to the base screwing the 2 screws fixing the 
receptacle.

• Repeat the same process for the other module if 2 small modules are to be used.

The 4000 V2 Platform must be switched off, and if it is operating on the 
mains, its supply cable must be unplugged.

Fig. 6 Fixing the module to the base

Captive screws fixing the module(s)

1a

2a

1b

2b
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Removing a module
1 Unscrew the two captive fixing screws of the module completely (up to the stop).

2 Remove the two slots of the module from their housing onto the base.

3 Carefully slide the module out of its slot.

Setting the 4000 V2 Platform into the glove
The glove for the 4000 V2 Platform is furnished on option with the instrument.

This glove has been designed to fit to the equipment, and to easily get access to all the 
commands of the product (interface, modules, connectors).

To set the 4000 V2 Platform in the glove, take care of the sense of insertion: the screen 
must face the front of the glove. Refer to Figure 7.
Once in the glove, the 4000 V2 Platform can be set to the «standing» position, using the 
stay on the back of the glove. 

Fig. 7 Platform View in the glove



Chapter 3 Starting up
Charging the battery

16 User Manual 74000NG012 Rev. 000

Charging the battery1

The battery supplied with the 4000 V2 Platform must be fully charged before use. 

A Lithium Ion type battery, 6 cells or 9 cells, is installed in the battery compartment.

Connecting the mains adapter

• At the top of the 4000 V2 Platform, lift up the power supply socket protector and 
plug in the mains adapter. 

• Connect the adapter to the mains. The On indicator lamp starts to blink in green.

First use of the battery
At the delivery, the battery is already set into the Platform, but its charge level is not 
«recognized» by the equipment.

The icon  is displayed on the upper banner of the screen.

To get a valid indication of the battery, and be able to use correctly the Platform:

1 Charge fully the battery

2 Once fully charged, discharge the battery by keeping the Platform switched on, 
but not plugged to mains.

3 The battery can then be charged, and the Platform used simultaneously.

1.if the 4000 V2 Platform is equipped with a battery.

CAUTION

Upon reception of the product, the battery of the 4000 V2 Platform 
needs to be fully recharged, no later than 6 months after the date of 
calibration.

If the product is unused for a long period, the battery needs also to be 
periodically fully recharged, with a period not longer than 12 months.

Use only the mains adapter supplied with the 4000 V2 Platform. The 
adapter for some other electronic device may appear to be identical, but 
entails a risk of damage to the 4000 V2 Platform.
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Charging 
If the instrument is fitted with a battery, on connection to the mains:

• if the user does not press ON, the battery will start the charge. In this case, the 
Charge indicator will be lit in red. 

• when the user presses the ON key, the instrument starts up and the battery will 
charge during use (Charge indicator in solid red).

Once the battery is fully charged, the Charge indicator lamp is solid green.

When the Charge indicator is blinking red, this mean the power supply is not compatible 
with the battery used. Charge is disabled.

Voltage must be superior to 14V to correctly charge the 9 cells battery (11V).

Only the 6 cells battery can be charged using the cigarette lighter adapter (provided on 
option). When this adapter is used with a 9 cells battery, the equipment can be used but 
the battery will not be charged (except if the vehicle is started). 

Battery charge level display
When the battery is installed in the instrument, its charge level is displayed in the top 
right-hand corner of the screen and also as a charge percentage. Example: .

• When the battery charge level drops below 10%, a warning is displayed next to 
the icon. Example:  When the level becomes too low, the instrument 
switches off automatically after saving the current configuration.

In the table below is a summary of the battery icon according to the charge level:

It is essential to wait until charging is complete to ensure maximum 
independent operating time, which may otherwise be considerably 
reduced.

Table 3 Color of the battery Icon according to charge level

Icon Charge level

From 100% to 70%

From 70% to 40%
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Switching the 4000 V2 Platform on and off
The mains adapter is used not only for charging the battery (if the battery is installed), 
but also for operating the 4000 V2 Platform on the mains, if a mains socket is at hand, 
to save the battery.

Switching on the 4000 V2 Platform
1 Press the ON/OFF key.

If the Platform is powered to mains, the battery will charge.

The On indicator pass from blinking to solid green. 

The Viavi logo appears on the screen briefly, then an auto test is carried out.

The equipment is ready to be used once all the applications are installed.

Switching off the 4000 V2 Platform
While the 4000 V2 Platform is operating, press the ON/OFF button to switch it off.

From 40% to 10%

From 10% to 0%

Table 3 Color of the battery Icon according to charge level

NOTE

It is possible to switch over from battery to mains operation, or vice versa, 
without loss of data.

The module cannot be swapped when the unit is ON or AC powered

In the event of an unexpected mains power cut, if there is no battery, 
the current results and configuration will not be saved. Next time the 
instrument is switched on, it will return to its initial configuration.
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Resetting the 4000 V2 Platform
If the 4000 V2 Platform freezes, prolonged pressure (about 4 s.) on the ON/OFF key will 
reset the instrument.

First start: configuring your regional settings
Once the 4000 V2 Platform is switched on, the first screen displayed allows to configure 
the regional settings.

Those settings will be kept in memory and automatically applied on the instrument each 
time it is restarted.

1 Click on Language and select the language to be used for the equipment.

Disconnect the jack connector of the AC/DC power supply before dis-
connecting the AC/DC mains

NOTE

When the instrument is switched off using the ON/OFF button, current results 
and configuration are saved. Next time the ON/OFF key is pressed, they are 
recalled.

Fig. 8 Regional Settings
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2 Click on Date and enter the current date, using the numeric keypad displayed 
using the menu key Edit Number.

3 Click on Time and enter the current time, using the numeric keypad displayed 
using the menu key Edit Number.

The date and time are displayed on the upper right side of the screen.

4 Click on Date Time Format and configure the following parameters:

– Date format: select one of the option dd/mm/yy or mm/dd/yy.

– Time format: select one of the option 24 hour clock or 12 hour clock.

Once all parameters have been defined, press Exit menu key to return to System 
Settings page.
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Chapter 4Configuring the 4000 V2 Platform

This chapter describes the operations for configuring the instrument.

The topics discussed in this chapter are as follows:

• “Displaying the System Settings screen” on page 22

• “Defining the screen parameters of the 4000 V2 Platform” on page 23

• “Defining the «Utility» parameters” on page 24
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Displaying the System Settings screen
To display the System Settings screen, you must:

1 Press the HOME key to reach the Home page.

2 Activate the Settings icon  to open the System Settings screen.

Fig. 9 Home page

Fig. 10 System Settings page

see “Talkset and 
Datalink Functions” on 
page 43

see “Transferring the 
interface on a PC via 
WIFI or Ethernet” on 
page 99

NOTE

If you are in the Regional Settings page, and you press Exit, then the Sys-
tem Settings page automatically displays.
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Defining the screen parameters of the 4000 V2 
Platform

In the System Settings page, the following parameters can be defined:

Backlight
1 Click on Backlight 

2 Define the backlight level of the screen, using the left and right direction keys, or 
clicking on Edit Number softkey and using the keypad displayed.

– Min backlight level: -5

– Max backlight level: +5

Contrast
1 Click on Contrast

2 Select the type of environment into which the instrument is used:

• Indoor: to be selected when the instrument is used inside (see Figure 10)

• Outdoor: to be selected in order to optimize the readability of the screen for an 
outside use.

If the 4000 V2 Platform is operating on battery, it is advisable to choose 
a minimum lighting level, acceptable for the user, to keep endurance 
as long as possible.

Fig. 11 Example of outdoor contrast
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Screen Saver
Click on Screen Saver if you wish to activate a screen saver to the equipment, to extend 
the life of the battery, in case the 4000 V2 Platform is not used for some time.

Instead of the normal screen, a small animated picture of the 4000 V2 Platform is 
displayed on the blackened screen. 

To configure the screen saver:

1 Click on Delay and select the time of inactivity before the screen saver 
starts: 60s, 3 min, 5 min.

The parameter No deactivates the screen saver function.

Defining the «Utility» parameters

Defining the Automatic shutdown of the 4000 V2 
Platform

The automatic shutdown function switches off the 4000 V2 Platform automatically if no 
operation has been performed and no key actuated for a period selected from this menu. 
Work in progress is automatically saved.

1 In the Utility box, click on Auto off parameter.

2 Choose a time after which the 4000 V2 Platform will be switched off automatically, 
if no action has been done for that period: 5, 10 or 30 minutes.

Select No if the 4000 V2 Platform must not be switched off, even if there is inactivity on 
the equipment.

Defining the Home selection
In the Home selection parameter, define the type of selection on the Home page:

• Single only one function can be deselected at the same time.

The function for automatically switching off the 4000 V2 Platform is 
available only on battery operation, to save the battery.
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• Multiple several functions can be selected at the same time.

NOTE

If the mode Single is selected, the activation of a function in the Home page 
will automatically display the result page for this function.
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Chapter 5Power meter, VFL (Visual Fault 

Locator) & Talkset

A variety of built-in optical options are available when ordering. See references in 
Chapter 11 “Options and accessories”, for details.

The topics discussed in this chapter are as follows:

• “Connection to the power meter, VFL and Talkset” on page 28

• “Using the Power meter” on page 28

• “VFL Function” on page 42

• “Storing and reloading results” on page 43

• “Talkset and Datalink Functions” on page 43
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Connection to the power meter, VFL and Talkset

The type of optical connector used for the power meter is UPP (Universal Push Pull), 
which is compatible with all diameter 2.5 mm connectors (FC, SC, ST, DIN, E2000, etc.)

Using the Power meter
The power meter function is an option chosen at the time of order and incorporated into 
the 4000 V2 Platform in the factory.

To activate the function:

1 Press the HOME button

2 Activate the power meter icon of the Platform .

The effect of this action will be to bring the power meter into use and to display 
the Results page for Power Meter.

Configuring the power meter
To access the configuration parameters of the Power meter, press the Multi-views key 
and select Setup.

Fig. 12 Optical connectors

Power meter / Talkset 
optical connection

VFL
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Configuring the alarm parameters
Alarm Activation of the Alarm function: any result below the lower threshold 

or above the upper threshold will be displayed in red on the Results 
page.

Min and max thresholds

Choice of lower and upper thresholds for each available wavelength, 
from -60 to +40 dBm (selected with the direction keys).

Configuring the Measurement parameters
In the Setup page, press Measur’t soft key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Measur’t) 

Fig. 13 Configuration of power measurement

NOTE

To copy one value of the Lower or/and Upper threshold for all wavelengths, 
select the reference value and click on Update for All Wavel..

NOTE

A continuous push on direction keys increments the value by 10 dBm.
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Wavelength Select wavelength:
Auto: the wavelength of the input signal will be automatically 
detected and selected to perform the measurement:
850, 980, 1300, 1310, 1420, 1450, 1480, 1490, 1510, 1550, 
1578, 1625 or 1650 nm: measurement performed at specified 
wavelength.
User: choice of wavelength on the next line

User choice (if the User option was selected in the Lambda line) selection of 
the wavelength between 800 nm and 1650 nm, by means of the 

direction keys and  (in 1 nm steps) or clicking on Edit 

Value to use the numeric keypad to enter a wavelength.

Beep on modulation Select if a sound must be heard when a modulation occurs (Yes 
/ No)

Unit Unit of power displayed:
Watt, dBm for displaying absolute power
dB for displaying a result relative to a reference (link loss)

Reference level If dB units were chosen in the previous line, selection of the 
reference value for the wavelength selected. Using the direction 
keys, first choose the wavelength, then press the > key to 
access choice of the value (+XXX.XX), then confirm this value 
with the ENTER key.This reference is also automatically 
available, in the Results page, using the Set as Reference key.

Attenuator compensation
Choice of level to be applied to the wavelength chosen for 
measurement to compensate for the loss due to the external 
attenuator (+XX.XX dB). First use the direction keys to choose 

the wavelength, then press  to access choice of value, then 

confirm this value pressing ENTER.

NOTE

Using MP 60 or MP80 power meter, set manually to Auto the Lambda to 
automatically detect the wavelength: in results page, press Power Config. > 
Wavelength key multiple times until Auto is displayed.
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Configuring the Link parameters
In the Setup page, press Link soft key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Link).

The information entered in the Link Description window concerns the editing and/or the 
modifications of the cable and fiber parameters. When a trace is recalled without recall 
of the configuration, the parameters of this trace will be present only in its signature.

Link Description

Fiber ID
Select the parameter Fiber Id and enter a name for the fiber, using the edition keypad.

Fiber Number
Select the parameter Fiber Number and modify the parameter using the left and right 
direction keys.

The fiber number can be automatically incremented/decremented at each new 
file save if it has been configured in the following parameter.

NOTE

To copy a Reference Level/Attenuator Compensator on all wavelengths, 
select the reference wavelength and click on Update for All Wavel..

NOTE

The softkey Copy File/Link To all is displayed when one parameter is 
selected in the Link or File Setup page and when the Powermeter function is 
active at the same time as another FO application (for example, OTDR 
Expert). 

It allows to apply the Link and File configuration parameters of the current 
applications to all the other active Fiber Optic applications (powermeter and 
source).
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Change Fiber Nbr 

Increment the fiber number is automatically incremented at each new file-save.

Decrement the fiber number is automatically decremented at each new file-save

User defined Use Edit Number softkey to enter the increment/decrement value for 
fiber number.

Note: to decrement the number, enter the sign «-» before the number. 
Example: -1.

Min: -999 / Max: 999 / Auto: 0

No the Fiber number must not automatically modified.

Cable Id
This parameter allows to enter an identification of the cable, using the Edition menu.

Direction
The direction shows if the acquisition has been made from the origin to the extremity (A-
>B) or from the extremity to the origin (B->A). Changing direction makes it possible, 
when different extremities are handled, to see the parameters of the fiber for the other 
extremity.

Location A
The name of the Location A of the link may be entered here.

Location B
The name of the Location B of the link may be entered here.

Project information

Technician Id
Use the arrow  to enter the name of the operator carrying out the measurement.

NOTE

The fiber number concatenated with Fiber Name are interdependent: they 
are incremented or decremented at the same time. 
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Job Id
Use the arrow  to enter a description of the measurement to be performed.

Comment
In contrast to the other data in this menu, the comment is specific to a fiber. This line is 
thus used to enter a new comment and not to display it. The comment appears at the 
top of the screen, with the other parameters of the fiber.
This comment will remain available for the next acquisition, unless it is deleted. It is also 
saved when a trace is saved with a comment.

Configuring the File parameters
The File storage parameters must be also configured, in order to define how the results 
will be saved on to the 4000 V2 Platform.

In the Setup page, press File soft key (if one parameter is selected in the current screen, 
press Top Menu soft key to display the right menu keys and click on File).

Directory Configuration

Dir. Naming
Click on Current Directory menu key to select the directory currently selected in the 
explorer for files saving

or

Use the arrow  to enter the directory name and path:

In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the directory. Then, press Enter to validate.

NOTE

The softkey Copy File/Link To all is displayed when one parameter is 
selected in the Link or File Setup page and when the Powermeter function is 
active at the same time as another FO application (for example, OTDR 
Expert). 

It allows to apply the Link and File configuration parameters of the current 
applications to all the other active Fiber Optic applications (powermeter and 
source).
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Example: disk/Powermeter

.

or

Press Auto Naming to apply the name by default to the directory:

disk/[Cable_Id]

Press Clear and validate (Enter key) in order to define the [Current directory] 
selected as directory for saving measurements.

Dir
This parameter cannot be configured, and display the directory selected by default into 
which the file(s) will be saved (the last directory selected).

Result Storage

Filenaming
Select Filenaming parameter and press the right arrow key to modify the name of the 
file for the result trace.

In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the file. Then, press Enter to validate.

Fig. 14 Directory - Edition keypad
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or

Press Default Filename to apply the name by default to the file:

Fiber[Cable_Id][Fiber_Num]_[Lambda]_[Direction]

The name of the file is displayed in grey under Filenaming parameter

Report Configuration

The powermeter results file can be saved with or without a report according to the config-
uration defined.

In the parameter Rapport As, select the format for the report which will be saved with 
the powermeter file:

No only the powermeter results are saved in a file with the extension.lts

Txt the results are saved, with the extension «.lts» and a txt report file is 
also generated.

If the text report is generated with the results file, the Report Layout parameters turns 
active:

Select the saving mode for the report:

Standard the report is saved in a standard txt file.

Consolidated the report is saved in a text file, into which results are consolidated. 

If the selected parameter is Consolidated, the following parameter, Report Naming, 
turns active and allows to enter a name for the report file. If no name is defined, the file 
will automatically be saved with the name Report_LTS.

Fig. 15 Filenaming - Edition keypad (auto)
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Saving configuration in a file
Once File and Measurement parameters have been configured, those parameters can 
be kept in memory and saved in a configuration file.

This configuration file can then be recalled in order to be applied when powermeter 
measurements are performed.

To save parameters in a configuration file:

1 If necessary, press the Multi-views key and select Setup to return to configura-
tion page.

2 Select one parameter in one of the setup page (acquisition, link..)

3 Press menu key .

An edition keypad displays

4 Enter a name for the configuration file (max. 20 characters).

5 Press Enter to validate

A sound is emitted to indicate the file is saved.

The configuration file is saved with the extension .fo_cfg (icon ) and can be 
recalled at any time from the Explorer page.

NOTE

Configuration file is saved by default in the directory disk/config/LTS.

Fig. 16 Save Configuration file - Edition keypad

Directory into 
which file will be 
saved
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Loading an existing LTS configuration
To load a configuration file previously created or available in the T-BERD/MTS/ Smar-
tOTDR and apply parameters to new Powermeter tests:

From the File Explorer page

1 Press Multi-views key and select File.

2 Select the configuration file desired.

3 Press Load > Load Config.

• Press the Multi-views key and select Setup to display the configuration parame-
ters saved in the selected configuration file.

You can modify some acquisition or file storage parameters, and save them in a new 
configuration file (see “Saving configuration in a file” on page 36).

From the Setup page

1 Select one header in either Setup page (Acquisition, Link, File...)

2 Press Load Config. menu key.

The file Explorer page displays

3 Select the configuration file desired

4 Press Load Config. to load the configuration file for measurements.

A sound is emitted to confirm the loading.

The Setup screen is displayed again.

NOTE

Most of the configuration files are available into the equipment, in disk/
config.
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Display of results and commands
The results page called up by the Multi-views > Results keys, gives the information 
relating to the measurement in progress, results previously saved and the commands 
available for measurement and saving.

Result of the measurement in progress
The power measured by the power meter is displayed in large characters, in the units 
selected in the configuration menu, together with:

• the mode of transmission of the signal measured: continuous (CW) or modulated 
to a frequency of 270Hz, 330Hz, 1KHz, or 2KHz.

• the wavelength of the signal measured. 

• the reference level expressed in dB.

• the level of Attenuation Compensation.

Table of results
For each fiber being tested, the power meter displays a table of 9 results corresponding 
to the different possible wavelengths. The first 4 results are displayed on the screen; to 
scroll through the other results, use the direction key . The table shows the power 
measured in dBm, the relative power (in dB) and the reference level in dBm (if units = 
dB), together with the mode.

Fig. 17 Loading a configuration file
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• A measurement result is displayed in the table when the Keep Result softkey is 
pressed. 

• The Clear Table softkey deletes all the results displayed in the table. 

• If the Alarm function has been activated, any result that exceeds the selected 
thresholds appears in red in the table. Otherwise, results are shown in the table in 
green.

• When the instrument is switched off, results present in the table are kept.

Commands of the power meter parameters
When the Powermeter function is selected, the following softkeys are available on the 
results page:

The different configuration buttons are displayed:

• Wavelength selection of the wavelength

• Unit choice of the unit

• Zero Adjustment of the Zero value when the power meter’s optical 
input is closed with a plug or cap (a validation is required).

On the results page, the following actions are available:

• Standard Reference
Selects the current result as reference value to measure the 
insertion of a link. This reference is displayed under the 
measurement result until a new reference is performed.

• Keep Result Keeps the result on the corresponding line of the table.

Fig. 18 Results and commands of the power meter

Results of the 
powermeter
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• Clear Table Deletes all the results displayed in the table.

If the Source function is selected (either on this Platform / base Unit or on an OTDR 
module), the Power meter results page is different:

• The choice of Wavelength, Unit and Zero menu keys are accessible via the 
menu key Power Config.

Performing a measurement
The power meter is started up as soon as the function  is activated in the 
HOME menu.

Power measurement
1 Connect the light source to be tested to the rear connector (see "Connection to 

the power meter, VFL and Talkset" page 28).

2 In the  configuration menu, choose the units dBm, dB or Watts.

3 Press the START/STOP key to start the measurement. 

The result will appear in the results page and can be memorized in the table (see 
"Table of results" page 38).

4 Press the START/STOP key to stop the measurement.

Optical link loss

Setting the zero value of the power meter

1 Fix the plug or cap over the optical input of the power meter so that no light can 
reach the photodiode of the power meter. If the zero adjustment is made without 
this plug, an error message may be displayed, as the photodiode will detect too 
much light.

Power measurement is automatically updated in consequence. The value 
«<-60 dB» is displayed when the laser is switched off and if the source out-
put is looped on to the power meter input.

It is important to set the zero of the power meter before performing any low 
power level measurement, when accuracy is critical, as the noise from the 
photodiode may fluctuate over time and with temperature.
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2 In the Results page, press the Powermeter Config. > Zero soft key and vali-
date.

Carrying out the reference measurement (1-jumper 
reference)

1 Fix the adapter corresponding to the jumper to the optical connector of the power 
meter.

2 Connect the jumper between the input of the power meter and the output of the 
source.

3 Configure the same wavelength on the source and the power meter.

The power measured is displayed in the results page of the power meter.

4 Press the Standard Ref soft key to save the result displayed as reference value.

Measurements on the fiber under test

After defining the reference value, proceed as follows to make the measurement:

1 Fix the jumpers and connectors needed to connect the fiber to be tested between 
the source output and the power meter input.

2 In the set-up menu, select dB units.

3 The power displayed in the Power Meter window corresponds to the optical loss 
of the link tested. It can be displayed in the table (see "Table of results" page 38).

Combo Powermeter/OTDR
If the ExpertOTDR mode is activated at the same time as the Powermeter, a menu key 
Combo PM/OTDR is displayed in the powermeter page.
It allows to launch an OTDR acquisition on the same port as the powermeter, clicking on 
Yes in the dialog box displayed.

CAUTION
Only the following OTDR modules  used in combination with the powerme-
ter, have the Combo PM/OTDR function; E4136RMAx, E4136RMPx, 
E4136RMP, Exx1xRMAx et Exx1xRMPx
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VFL Function

VFL connector
The type of optical connector used for the VFL source is UPP (Universal Push Pull), 
which is compatible with all diameter 2.5 mm connectors (FC, SC, ST, DIN, E2000, etc.)

See Figure 12 on page 28 to visualize the VFL connector.

Visual Fault Locator function (VFL)
This function is used to emit a red light signal of frequency 1 Hz or in continuous mode 
into a fiber to detect any defects in the dead zone of the reflectometer, or to identify it. 
This function is suitable for short fibers (length < 5 km) or the first few meters of a long 
fiber.

To emit a light signal into a fiber:

1 Connect the fiber to the VFL port on the connectors panel.

2 Press the HOME key and activate the VFL .

The icons  display on the upper banner of the screen.

The signal mode of the VFL can be modified in the System Settings page, in Utility > 
VFL Mode parameter.

Fig. 19 Combo Powermeter / OTDR

NOTE

Identification is facilitated by the blinking of light in the fiber.
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Storing and reloading results

Storing results
In order to save the results of a measurement, click on Multi-Views key and select File 
and press the menu key Store trace. Two files are being saved:

• The first file is used with the 4000 V2 Platform and allows to retrieve all measure-
ment results. It is saved with the extension «.Lts».

• The second file is a ASCII file using tabulations to separate values. It is saved 
with the extension «.txt» and can be opened by the 4000 V2 Platform. It has been 
designed to be used with a spreadsheet program on a PC where it allows to 
retrieve all measurement results and format them in a nice customized table. 

Loading results
In order to load the results of a measurement, select a file  with the extension «.Lts» 
in the file explorer (see the chapter «File management» in the user manual for «2100 
modules series»), click on Load.

The LTS tab is displayed with the loaded results in the table

Talkset and Datalink Functions
The Talkset option enables two operators at opposite ends of an optical link:

• To communicate along the fiber.

• To transfer data along the fiber. 

Each end of the optical link must be provided with a 4000 V2 Platform equipped with the 
Talkset option.

NOTE

Press CANCEL button on the Platform to deactivate the VFL.
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Talkset configuration
The talkset configuration is set in the System Settings screen, in the Channel box (see 
“Adjusting volume level” on page 47)

Connections
At each end of the fiber:

1 Connect the fiber to the Talkset port of the 4000 V2 Platform, either directly or 
through jumpers.

NOTE

It is possible to use the Talkset of the 4000 V2 Platform and to carry out mea-
surements at the same time, on a different fiber.

NOTE

It is possible to use the Data transfer feature while using the optical tele-
phone of the 4000 V2 Platform. Nevertheless, the data transfer speed will be 
slightly decreased.

NOTE

The Talkset option is delivered with a FC adapter mounted on standard on 
the talkset connector.

In addition to the FC adapter, a SC adapter is also delivered with the Talkset 
option.

Viavi recommends you to use the following connections:

- PC Fiber Connection (APC is not recommended)

- SC or FC connection (UPP is supplied but not recommended)
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2 A headset (with earphones and a microphone) supplied with the option may also 
be plugged into the 4000 V2 Audio jack.

Establishing communication
On the caller 4000 V2 Platform, press the HOME button, then validate the desired func-
tion:

• Talkset (Optical Telephone): used to communicate via the fiber.

• Datalink : used to transfer data, perform OEO measurements or remote 
screen using the fiber.

If the remote instrument is ready to receive (on standby), the Talkset/Datalink icon turns 
yellow, beeps are emitted, and

• the icon  appears at the top of the screen: telephone communication can now 
take place. 

• the icon  appears at the top of the screen: data transfer can now take place.

If the remote instrument is not ready to receive, the icon does not change color and a 
message is emitted.

Fig. 20 Installation for Talkset use

NOTE

Data transfer uses the same fiber as the optical telephone
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Remote screen function via Optical Datalink
This enables an operator at one end of an optical link to take control over another 4000 
V2 Platform connected at the other end, using the fiber.

Establishing communication
1 On the caller 4000 V2 Platform, press the HOME button, then select and confirm 

the Optical Datalink option:

– If the remote instrument is ready to receive (on standby), the Optical Datalink 
icon turns yellow, beeps are emitted, and the icon  appears at the top of the 
screen: data transfer, remote screen or oeo measurements can now take place. 

– If the remote instrument is not ready to receive, the Optical Datalink icon does 
not change color and a message is emitted.

2 Click next on Connectivity

3 In the connectivity screen, click on Switch to remote screen.

Your screen is now fully replaced by the distant screen, and everything you do on 
your 4000 V2 Platform is in fact done on the distant 4000 V2 Platform.

NOTE

The talkset icon is displayed on the top banner as long as communication 
remains established, letting the user know that the connection is working.
When communication is established, the headset is automatically enabled if 
plugged in. However, the loud speaker must be correctly configured in the 
setup menu to work accordingly 

NOTE

Data transfer varies according to the type of application you use. For Fiber 
Optics for example, you can use the explorer. The distant 4000 V2 Platform 
will be shown just like a disk and all file and directory features can be used 
from and to that disk.

NOTE

Each end of the optical link must be provided with a 4000 V2 Platform 
equipped with the Talkset option.
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An icon  appears in the top banner of the 4000 V2 Platform.

Adjusting volume level
The sound is transmitted to the earphones of the headset and, if this function has been 
activated, to the speaker in the 4000 V2 Platform. To activate the base loudspeaker and 
adjust the volume:

1 Press the HOME key.

2 Validate Settings icon to reach the System Settings page.

3 Under the Audio box, adjust Headset Volume (from 0 to 100). 

End of a VNC session
In order to end a VNC session, you can:

1 Return to the Connectivity page and click on Return to local screen. (Recom-
mended solution)

or

Deactivate the Optical Datalink function on either 4000 V2 Platform connected.

A short sound is emitted to indicate the disconnection is done, and the icon 
Optical Datalink turns inactive.

2 Disconnect the fiber

Disconnection
When communication is over: 

1 Deactivate the Talkset/Datalink function on one of the 4000 V2 Platform. 

2 This deactivation can be done by either 4000 V2 Platform.Then, the fiber used 
can be disconnected safely.

A slight normal color degradation may be seen on the 4000 V2 
Platform controlling a distant instrument.

NOTE

The VNC icon in the top banner of the screen lets you know at all times 
whether you are in a VNC session or not.
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Chapter 6Scope

The scope function is a hot-plug feature enabled directly when inserting a Viavi scope 
supplied as an accessory (see Chapter 11 “Options and accessories”):

The topics discussed in this chapter are as follows:

• “Scope feature” on page 50

• “Installation of tips” on page 51

• “Configuring the P5000i Scope” on page 51

• “Starting up with the scope” on page 57

• “Launching a test of the connector and fiber end-face” on page 59

• “File menu” on page 63
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Scope feature

Overview
This feature enables you to verify that your optical connectors are in perfect shape and 
very clean condition.

The P5000i Digital Probe Microscope is a portable handheld microscope used to view 
and inspect both the bulkhead (female) and patch cord (male) sides of fiber connectors 
as well as other optical devices, such as transceivers.

The P5000i requires an FBPT inspection tip and is connected to the 4000 V2 Platform 
with a USB 2.0 connector.

Figure 21 P5000i Probe components

QuickcaptureTM button
Instantly captures (and analyzes) fiber image

Focus Control

Latch lock
Squeeze both ends to release

Barrel assembly USB 2.0 
connector

6 FT COIL Cable

Inspection tip

Magnification Control

Before using the P5000i scope, make sure the Bluetooth option has 
not been activated, even once, after the start of the MTS/ T-BERD 4000 
V2. If it has been activated, stop and restart the equipment before 
using the P5000i Scope.
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Installation of tips
The Pass/Fail analysis function on the 4000 V2 Platform can only be used with certain 
inspection tips mounted on the P5000i.

Seven tips, patchcords and bulkheads types, are delivered with the Videoscope Kit 
(ESDFSCOPE5Ki) but many others can be used.

Configuring the P5000i Scope

Scope connection
1 Plug in your Viavi scope into a USB port from the Platform 4000 V2.

2 Push the button HOME.

3 Validate the Scope function .

4 Connect probe with the fiber being inspected.

You may select this option while other options are already selected (e.g. OTDR).

Configuring the Scope
1 Press Multi View key and select Setup to configure the test.

The following screen displays:

Figure 22 P5000i Scope Setup
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Analysis

Profile
On the line Profile, select the Profile which will be used for the test of fiber connector:

• SM_UPC: Pass/Fail criteria for single-mode UPC connectors from IEC 61300-3-
35 standard.

• SM_APC: Pass/Fail criteria for single-mode APC connectors from IEC 61300-3-
35 standard.

• SM_PC: Pass/Fail criteria for single-mode PC connectors from IEC 61300-3-35 
standard.

• MM_: Pass/Fail criteria for multimode connectors from IEC 61300-3-35 standard.

Profiles contain the analysis parameters by which PASS/FAIL criteria are determined.

Once the line is selected, you can also add a new profile, clicking on the Add Button (see 
“Defining the profiles available on the Setup screen” on page 56).

Tip
On the line Tip, select the tip set onto the scope to connect fiber for inspection.

Capture button
This parameter allows to select the action of the Quick Capture button onto the Scope 
(see Figure 21 on page 50):

• Freeze & Test pressing the button will automatically perform a test of fiber and 
freeze the result

• Freeze image pressing the button onto the Scope will automatically freeze the 
live image.

Auto Center
This parameter allows to select if the scope image must be centered on screen (select 
Yes) or not (select No).

Advanced focus (focus meter)
This parameter allows to define if the advanced focus must be used (Yes) or not (No).

The advanced focus displays a Red / Yellow / Green bar graph to indicate the focus level 
and the image sharpness.
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Link
In the Setup page, press Link softkey (if one parameter is selected in the current screen, 
press Top Menu soft key to display the right menu keys and click on Link).

The information entered in the Link window concerns the editing and/or the modifications 
of the cable and fiber parameters.

• Fiber Id Use the edition keypad, which will display by clicking on the 
right arrow key, to enter a specific name for the fiber. 

• Fiber Number Use the numeric keypad, which will display by clicking on the 
right arrow key, to enter the fiber number.

• Change fiber Nbr Select if the fiber number must be modified after each results 
saving:

No: the fiber number is not modified at each saving

Increment; the fiber number is automatically incremented at each results saving

Decrement: the fiber number is automatically decremented at each results 
saving.

• Cable Id This parameter allows to enter an identification of the cable, 
using the Edition menu.

• Direction The direction shows if the acquisition has been made from the 
origin to the extremity (A->B) or from the extremity to the origin 
(B->A). Changing direction makes it possible, when different 
extremities are handled, to see the parameters of the fiber for 
the other extremity.

• Location A The name of the Location A of the link may be entered.

• Location B The name of the Location B of the link may be entered.

• Company Enter the name of the company carrying out the test.

• Technician Id Enter the name of the operator carrying out the test.

• Job Id  This line is used to enter a description of the job in progress.

File
In the Setup page, press File softkey (if one parameter is selected in the current screen, 
press Top Menu soft key to display the right menu keys and click on File).

NOTE

All parameters of the Link Description box will appear in the pdf report or jpg 
file generated from a test results page.
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The File box allows to configure the saving of scope results.

Dir. Naming
Click on Current Directory menu key to select the directory currently selected in the 
explorer for files saving

or

Use the arrow  to enter the directory name and path:

In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the directory. Then, press Enter to validate.

Example: disk/Scope results

Press Clear and validate (Enter key) in order to define the [Current directory] 
selected as directory for saving measurements.

Dir
This parameter cannot be configured, and display the directory selected/created by 
default into which the file(s) will be saved.

Filenaming
Use the edition keypad, which will display by clicking on the right arrow key, to enter a 
specific name for the file. You can enter manually a name and/or use pre-defined param-
eters (Fiber Id, Cable Id, Locations...).

Fig. 23 Directory - Edition keypad
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In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the file. Then, press Enter to validate.

or

Press Default Filename to apply the automatic name to the file: 
Fiber[Cable_Id][Fiber_Num]_[Direction]

Below Filenaming, the name of the file is displayed.

Logo
Click on right arrow key and select in the Explorer a JPG file which will represent the 
Logo displayed on the upper left part of the report 

Save mode
Select if the test results must be saved only in an Image, only in a pdf Report or in an 
image + a pdf report (Image + Report).

Auto Store
Select Yes if the saving must be done automatically after a test, or No if the saving must 
not be done automatically.

Press Exit to return to the Results screen of the scope.

Managing scope profiles
Once the Setup screen of the scope is displayed, you can :

Fig. 24 Filenaming - Edition keypad (auto)



Chapter 6 Scope
Configuring the P5000i Scope

56 User Manual 74000NG012 Rev. 000

• Select / unselect a profile from the list, which will be available / unavailable in the 
Setup screen.

• Add a profile to the existing ones.

Defining the profiles available on the Setup screen
Once in the Setup page of the Scope application:

1 Select the Profile parameter to open the sub-menu

2 In the right menu keys, press Manage.

3 From the Profiles list, click on one profile (in video reversed) and press Select / 
Unselect menu keys to add or remove this profile to/from the sub-menu of the 
Setup screen

or

Directly click on the check box of the profile to select/deselect it.

4 Press Top Menu softkey to go back to Setup page.

The changes are applied at selection.

Importing a profile to the Scope application
The profile must be created via FiberChek2TM, and stored on one storage media of the 
Product Name/Family Brand (disk, or USB memory stick).

1 On the Setup screen, select Profile and press Manage.

2 From the Profile list, press Add menu key.

Figure 25 List of profiles available
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3 On the explorer, select the file which will be used as profile (icon ; extension: 
.PRO)

4 Press Load.

Once loaded, the display goes back automatically to Manage Profile screen.

5 Select the profile just loaded.

6 Press Top Menu to return to Setup screen and select the profile just added.

About page
On the Setup screen, the softkey About, on the right of the screen, allows to display 
information on scope and current test result displayed (in Full Screen mode or mosaic 
mode - see “Mosaic Mode” on page 61).

1 Press About softkey to display a page as the following one:

Starting up with the scope
Once the Fiber Scope icon is validated:

1 Press the Multi-views key and select Results.

Figure 26 P5000i Scope: About page

Information on 
scope used

Information on 
active snapshot
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Use the Focus Control button onto the P5000i scope (see Figure 21 on page 50) to 
adjust the image quality and sharpness.

Freeze mode
Once the image is acceptable, you may freeze the picture. This feature allows to store 
in memory the resulting picture.

High Mag. / Low Mag.
The High Mag./Low Mag. menu key allows to switch the display from High to Low 
magnification and vice-versa.

This function is also available pressing the button directly on the P5000i (see Figure 21 
on page 50). 

Figure 27 Example of the result using the P5000i scope

Sharpness 
level

Freezing a scope result does not store the picture in a file (see “File 
menu” on page 63). The result will be lost if the instrument is shut off, 
or if more than 3 pictures are frozen (see “Mosaic Mode” on page 61)

NOTE

The button set on the lead, or the QuickCapture™ on the P5000i allows to 
freeze the picture or to take a snapshot.
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Live mode
If you are in Freeze mode, or in Mosaic mode, with a picture selected (see “Mosaic 
Mode” on page 59), press Camera menu key to return to live camera picture.

Launching a test of the connector and fiber end-
face

Launching a test of the connector and fiber end-face
Once the display is correctly adjusted (magnification, sharpness...), a test of fiber 
connector can be launched.
To launch the test:

1 Press Test key or QuickcaptureTM button to launch the test of plugged fiber 
connector.

The test is completed:

– once the Led Testing is no more lit in red

– once the icon  is no more displayed on the upper banner

– once a screen as the following one displays:

Use the focus control to adjust the focus of the image

NOTE

To configure Pass/Fail criteria, see "Configuring the Scope" page 51.
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A summary of test results is displayed on the right, upper part of the screen.

• Zone A: Core zone: it is the area surrounding the core

• Zone B: Cladding zone. It surrounds the majority of the 
fiber cladding.

• Zone C: Epoxy ring.

• Zone D: Ferrule/Contact zone: it identifies a portion of 
the ferrule near and around the fiber

Figure 28 Test results

Test result 
in High mag.

Summary of 
Test results

NOTE

To return to a Live Camera image, press the Camera key; or press the Full 
Screen/Mosaic key view both the live image and a test result simultane-
ously.

In Mosaic mode (see "Mosaic Mode" page 61), the result of the test only dis-
plays Pass or Fail information; the status of each zone is displayed only in 
full screen mode.

Zone C
Zone B

Zone A

Zone D
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Overlay
The Overlay key allows, when selected, to display the limits of each zone and to display 
with colors the defaults on the image.

When the key is deselected, the zones and defaults are not graphically identified.

This function is also available in Mosaic Mode (see “Mosaic Mode” on page 61).

Mosaic Mode
It is possible to display only one picture in full screen (640 * 390 pixels) or up to four 
pictures (320*180 pixels each, including the live camera picture) in mosaic mode. Use 
the key Full scr./Mosaic to switch from one mode to another.

• You may select one of the pictures by clicking on it.

The selected picture is framed in green.

The tool bar on the right varies according to which picture is selected (camera, or static 
picture):

Figure 29 Mosaic mode

Position 1:
LIVE CAMERA

Position 2:
File saved on disk

Selected picture
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Picture selected: Live
• Test Allows to launch a (new) test of the connector (see “Launching 

a test of the connector and fiber end-face” on page 59) 

• Freeze The live picture from the camera is frozen but does not replace 
the live picture at position 1. The new snapshot is placed at the 
second position, and all existing pictures are pushed to the 
next position.

• High mag./Low mag.
allows to modify the live display from high to low magnification 
and vice-versa

Picture selected: Image
• Comment allows to add a comment to the selected picture (see “Adding a 

comment” on page 62)

• Save allows to save the selected picture in the directory Scope, in 
the disk of the Platfom. Press Save key, enter a name for the 
jpg file and validate. This key is not available with jpg files other 
than those resulting from scope application.

• Overlay allows to display or hide the limits of each zone and the 
defaults on image from a test result (see “Overlay” on 
page 61).

• High mag./Low mag.
allows to switch all the images from scope test results from 
high to low magnification and vice-versa.

Adding a comment

The key Comment allows you to enter/modify a comment to your picture if necessary. 
This comment appears at the bottom left of the picture. 

The right bottom of the frozen picture also contains the date of the acquisition (where the 
picture was frozen).

If all positions were taken, the picture that was once at the fourth position is 
unloaded from memory. Frozen pictures and snapshots are lost, unless they 
were saved on the internal memory.
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Loading a picture
It is possible to retrieve and load a picture stored in the Scope directory and display it in 
the Scope page.

1 Press the Multi-views key and select File.

2 Press Explorer. 

3 Select the JPEG file to be loaded via the Explorer

4 Click on Load

Recognized pictures are images resulting from the Scope option and saved on disk via 
the 4000 Base Unit.

Even though the JPG editor of the Scope function has been designed to display Scope 
pictures in black & white, it is also possible to open any JPG valid file and display in color 
the corresponding picture. That picture is enlarged or shrunk to the size of the display 
(full screen or mosaic, see."Mosaic Mode" page 61).

File menu

Saving the test result in a jpg file and / or in a report
Once the test has been performed, and the result is displayed on the Product Name/
Family Brand screen:

1 Click on Save Image soft key to save a jpg file and / or a pdf report of the test 
result on the disk of the Product Name/Family Brand.

2 On the edition keypad, enter the name of the file(s)

3 Press Enter to validate.

NOTE

Both the comment and the date will be saved with the picture.

Some pictures resulting from the Scope option may appear neverthe-
less unrecognized, if they have been stored with a different Scope 
application, or if the JPG file has been opened and modified under 
another JPG editor.
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The file is automatically saved on the disk, in the directory Scope (icon  for 
jpg file, icon  for report).

The jpg file includes pass/fail and setup information which is used for combo 
report with OTDR (see OTDR User Manual)

Display of the report
Once the report has been generated:

1 Press the Multi-views key and select File.

2 In the File Explorer, select the pdf report just created.

3 Press Load.

Figure 30 PDF report of Scope test result

Parameters selected in 
the Setup page (see 
“Configuring the Scope” 
on page 51)
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Chapter 7Connectivity

This chapter describes the different ways to access to the 4000 V2 Platform interface or 
content using different connection modes.

Topics described in this chapter are as follows:

• “Establishing connection” on page 66

• “Remote Control” on page 78

• “Stratasync” on page 102
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Establishing connection

Via Bluetooth
The Bluetooth interface allows interface and file transfers. 

It is an option that must be installed at the factory, and it is available with the WIFI option.

Pairing the Platform with a device
1 On the Home page, press Connectivity key

2 Under Connectivity page, select Bluetooth

The following screen displays

3 Press the menu key Bluetooth  to enable the Bluetooth interface.

The product is approved in accordance to R&TTE directive concerning 
transmitter module marked by CE0678. It is manufactured by MITSUMI 
and it is an OEM product.

This device complies with Part 15 of the FCC Rules. Operation is sub-
ject to the following two conditions: (1) this device may not cause 
harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation. 
This device contains FCC-ID: POOWML-C40.

Fig. 31 Bluetooth disabled
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The icon  is displayed on the upper banner of the screen

The Paired Bluetooth Devices screen appears

4 Press the Become Pairable soft key to wait for another device to initiate the 
connection to the 4000 V2 Platform.

A screen as the following one displays:

5 Activate Bluetooth on the equipment which need to be paired with the Platform

6 If you are asked to, validate a pairing code on the equipment.

7 In this case, validate the pairing code on both equipments.

Both equipment are now paired:

Fig. 32 Waiting for pairing

Fig. 33 Platform paired with one equipment
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The icon has a blue background when paired with a device , versus no back-
ground when not paired .

Searching new devices to be paired with the 
Platform
1 If the desired device is not displayed on the screen, or if no devices are detected, 

press the Search Devices soft key.

The 4000 V2 Platform is searching for the devices which could be used via Blue-
tooth with the equipment.

A bargraph is displayed during research .

Once the research is completed, a list of the available devices is displayed, with 
the level of detection of the 4000 V2 Platform 

a Select the device to be paired with the Platform

It will be underlined in blue.

b Push the Pair key to connect the device to the Platform

2 If prompted, enter a pairing code. The code must be identical on the 4000 V2 
Platform and the device.

REMINDER

You may need to activate bluetooth on the other device to allow pairing.

Fig. 34 List of devices found
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3 Once the bluetooth device and the Platform are paired, a screen is displayed with 
the description of the device (see Figure 33 on page 67).

The icon has a blue background when paired with a device , versus no back-
ground when not paired .

You can now go to the file explorer and transfer files from the 4000 V2 Platform toward 
the bluetooth device and vice versa (see “Transferring files via Bluetooth” on page 95) 
or transfer the Platform interface on VNC via Bluetooth (see “Transferring files to/from a 
PC via WIFI or Ethernet” on page 96).

Removing the Pairing
To remove the pairing between the two equipments

1 From the Home page, press Connectivity > Bluetooth.

2 Push the Remove pairing key

The icon on the upper banner of the screen becomes  showing the Platform is no 
more connected to a bluetooth device, but the Bluetooth option is still active.

To deactivate the bluetooth onto the Platform, press Bluetooth menu key to disable the 
interface.

Via Wifi
The WIFI application is available on option with the 4000 V2 Platform, ref E10WIFI.

Configuring the WIFI access
1 Restart the 4000 V2 Platform, pressing ON button.

2 On the Home page, press Connectivity .

The Connectivity page opens.

3 In the new page, select the WIFI icon .

The WIFI Setup screen displays.

4 Press Wireless menu key to enable the Wifi interface.

The icon  is displayed on the upper banner.



Chapter 7 Connectivity
Establishing connection

70 User Manual 74000NG012 Rev. 000

Once the Setup screen is displayed, configure the WIFI connection:

5 Press Scan SSID menu key to scan for Service Set Identifiers (SSIDs) in the 
area.

6 Wait for the list of SSIDs to be displayed.

7 Select the desired network to connect to.

8 Press Select menu key to validated the connection.

The display goes back to Setup screen.

The SSID parameter is automatically configured with the one selected.

Fig. 35 WIFI Setup screen

Fig. 36 List of SSIDs found
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9 In Encryption parameter, select the type of encryption wished: None, WEP 
Static, WPA Personal, WPA Enterprise.

10 According to encryption type selected, enter Login (if any needed) and Key/
Password.

11 In the AutoConnect parameter, select if the connection to SSID selected must be 
done automatically (On) or not (Off).

Connection to SSID
Once configuration is valid, connect the 4000 V2 Platform to the Wireless network:

1 In the Setup screen, press Connect SSID menu key.

or

If AutoConnect is defined to On, the connection is launched automatically.

Once association of Platform with SSID is established, the icon    becomes 
 to indicate the connection is active.

Configuring the WIFI mode to which the Platform is 
connected
To work on WIFI with the Platform, configure the 802.11 parameter on the WIFI Setup 
screen.

1 Select the mode of connection: 

• Config 1 to 4 static mode enabling input of the configuration of 4 sites. If this 
parameter is selected, the following parameters must be 
entered:

– Site Name the user can enter the name of the site in the Edit menu.
– IP Address IP address of the 4000 V2 Platform
– IP Mask address of the mask of the sub-network
– IP Gateway IP address of the machine enabling access outside the sub-

network.
– DNS (Domain Name Server) IP address of the machine providing the 

IP address on the basis of the name

NOTE

Login and Password are kept in memory, even if the WIFI is deactivated or 
the 4000 V2 Platform switch off and restarted.
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– Domain name name of the local network to which the 4000 V2 Platform is 
connected.

• Dynamic in this mode, which requires a DHCP server, the 4000 V2 
Platform requests an IP address from this server which will be 
allocated dynamically if dynamic host configuration is activated 
on the local network.
After selecting this mode or after power-on, the 4000 V2 
Platform tries to establish a connection to obtain an address 
from a DHCP server. If for any reason, this process fails, the 
4000 V2 Platform reverses to static IP address mode with 
User1 IP address.

Note the IP address of the Platform, to be able to remote screen on PC or to transfer 
files.

2 Configure the Proxy dialog box:

In the Use proxy parameter

– Select No if no proxy is used.

– Select Manual to enter manually the Proxy address

– Select Auto and enter the Pac address.

Creating a network from the 4000 V2 Platform
A WIFI network can be created from the 4000 V2 Platform, in order to associate it to a  
Smartphone or Tablet.

1 From the Home page, press Connectivity > Wireless 802.11.

2 On the Setup screen, select the Wlan Mode for WIFI connection: Ad-hoc (IBSS) 
or AP Master.

3 Press Create Network menu key and wait for the network creation.

Fig. 37 WIFI connection in Dynamic mode

Note IP 
Address
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The network creation on platform is completed once the dialog box is no more 
displayed.

4 On the Smart device, open the Wifi setup age.

5 Check the Platform has been detected (SSID identifier displayed in the list of 
WIFI networks found)

6 Click on this SSID and follow the instruction on your Smart Device to link it to the 
Platform.

Via Ethernet
The connection between 4000 V2 Platform and the PC can be done directly, or via a 
local network.

Connecting the 4000 V2 Platform and the PC
1 Connect the 4000 V2 Platform to the PC via an Ethernet cable, using the USB 

Ethernet - adapter and an Ethernet cable.

Fig. 38 Connection 4000 V2 Platform and PC
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2 Make sure the network configuration onto the PC is set to the Dynamic mode:

a Click on Start > Control Panel.

b Double click on Network Connection.

c Double click on Local Area Connection.

d In the dialog box, click on Properties.

e Check the parameter Internet Protocol (TCP/IP) is selected ( ) and click 
once on it (underlined in blue)

f Click on Properties button.

g On the tab General, check the parameter Obtain an IP address automati-
cally is selected ( ); if not, click to select it.

h Click on Ok and close all the dialog boxes opened onto the PC.

Configuring the 4000 V2 Platform via Ethernet
1 In the Home page, validate the Connectivity icon.

2 In the connectivity page, validate the Ethernet icon .

3 In the I/O Interfaces box, configure the following parameters:

Ethernet > Mode

Parameters of the local Ethernet network to which the 4000 V2 Platform is connected:

Fig. 39 Internet Protocol
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• Config 1 to 4 static mode enabling input of the configuration of 4 sites. If this 
parameter is selected, the following parameters must be 
entered:

– Site Name the user can enter the name of the site in the Edit menu.
– IP Address IP address of the 4000 V2 Platform
– IP Mask address of the mask of the sub-network
– IP Gateway IP address of the machine enabling access outside the sub-

network.
– DNS1 IP address of the machine providing the IP address on the basis 

of the name
– Domain name name of the local network to which the 4000 V2 Platform is 

connected.

• Dynamic in this mode, which requires a DHCP server, the 4000 V2 
Platform requests an IP address from this server which will be 
allocated dynamically if dynamic host configuration is activated 
on the local network.
After selecting this mode or after power-on, the 4000 V2 
Platform tries to establish a connection to obtain an address 
from a DHCP server. If for any reason, this process fails, the 
4000 V2 Platform reverses to static IP address mode with 
User1 IP address.

Proxy > Use proxy

1 Select No if no proxy is used.

2 If Manual has been selected, enter the Proxy Address.

3 If Auto has been selected, enter the Pac Address.

1.Domain Name Server

NOTE

Once the 4000 V2 Platform is connected to the network, the icon , indi-
cating the connection is working, displays for few seconds.



Chapter 7 Connectivity
Establishing connection

76 User Manual 74000NG012 Rev. 000

4 Note the IP Address.

5 Wait about 10 seconds the connection is established.

The 4000 V2 Platform Interface can now be transferred onto the PC, or the internal 
memory or USB key contents can be transferred on PC.

Via Cloud Storage

Principle and prerequisites of the Cloud Storage
The Cloud storage defined the outsourcing of data on distant servers, which avoid the 
data storage on a local workstation.

The cloud storage onto a 4000 V2 Platform allows to transfer the files from the Platform 
toward a distant server and vice-versa.

Before configuring the Cloud Storage on Platform, you must first create an account on a 
Cloud Platform on internet. 

The Cloud storage function onto the 4000 V2 Platform works exclusively with sites using 
the WebDav technology such as CloudSafe (https://secure.cloudsafe.com/pages/
index.html) or Box (https://www.box.com/pricing/).

Once account is created, with WevDav configuration, you get the following information 
for connection:

– URL 

– Login Name

– Login Password

Fig. 40 Example of configuration for I/O Interfaces box

Note the 4000 V2 Platform 
IP Address

https://www.box.com/pricing/
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Configuring and connecting to Cloud Storage on the 
4000 V2 Platform

Configuring the 4000 V2 Platform

Once an account has been created on the Cloud site, configure the 4000 V2 Platform 
before establishing the connection:

1 On the Home page, press Connectivity.

2 In the Connectivity windows, press Cloud/File Storage .

A new page opens

3 In the Url parameter, enter the URL define for the Cloud server created on 
internet

4 In the User parameter, enter your Login created on your account

5 In the Key / Password, enter the password attributed by the Cloud server.

Connecting Cloud Storage

Once configuration has been established on the 4000 V2 Platform, it is ready to be 
connected with Cloud server:

1 Select one parameter of the Cloud Storage window on 4000 V2 Platform

Before configuring the Cloud Storage, make sure the configuration for 
Ethernet parameters and Proxy parameters are correctly configured. 

See “Ethernet > Mode” on page 74 and “Proxy > Use proxy” on page 75.

Fig. 41 Example of configuration

Configuration on Cloud server 
(example with CloudSafe)

Configuration on 
4000 V2 Platform
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2 Press Connect Cloud Storage menu key .

The connection launches

3 Once connection is established, a message displays in the window

4 Press any key to continue, and start files transfer.

The icon  is displayed on the upper banner as long as the connection is active.

Disconnecting from Cloud storage

To disconnect the 4000 V2 Platform from Cloud storage:

1 Press HOME hard key.

2 Press Connectivity > Cloud/File storage.

3 Select a parameter of the Cloud Storage window.

4 Press Disconnect Cloud Storage menu key.

Remote Control

Smart Access Anywhere
The 4000 V2 Platform can be accessible to any network test locations, using a specific 
function: Smart Access Anywhere. 

This function allows one distant user, on a PC, to transfer the Platform Interface and 
work on 4000 V2 Platform or to access the internal memory / USB memory stick contents 
on the PC and perform files transfer from 4000 V2 Platform to PC and vice-versa.

This feature does not need any licence code if the user wants assistance from a Viavi 
person located within the Viavi network.
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This feature requires a licence code into the unit if the user wants any other assistance/
support (“company A” willing to be remotely controlled by “company A or B”).

The license SAA-2K-L2 is used for SmartAccessAnywhere using Ethernet, wifi hostpot 
connection, or USB / Wifi connection through 3G smartphone

The 4000 V2 Platform can be used in combination with a PC in order to transfer the Plat-
form Interface onto a PC, or to access the internal memory or USB memory stick 
contents on the PC. 

Connection modes
Different kinds of connection are available to access to a distant 4000 V2 Platform.

According to the connection type used, specific requirements are mandatory.

Ethernet or WIFI connection

1 Using the Ethernet connection, no specific requirement is needed. The platform is 
directly connected to Internet via an Ethernet Cable.

2 The WIFI connection can be used to access to 4000 V2 Platform from any loca-
tion.

This connection is available exclusively if the WIFI option is installed onto the 
4000 V2 Platform which will be seen remotely.

Fig. 42 Ethernet connection
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USB/WIFI connection via Smartphone (Tethering)

To access to a 4000 V2 Platform remotely, the connection between the unit and the Viavi 
application can be established via a USB cable or WIFI, and through a Smartphone, 
having Internet Sharing capability via USB or WIFI.

1 To establish connection between 4000 V2 Platform and Smartphone using USB, 
connect the USB cable on 4000 V2 Platform and on Smartphone connector.

2 To establish connection between the 4000 V2 Platform and Smartphone using 
WIFI, the WIFI option must be installed onto the 4000 V2 Platform.

Fig. 43 WIFI connection

Fig. 44 USB connection through Smartphone
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Pre-requisite for using the Smart Access Anywhere 
Application
To access to a 4000 V2 Platform from any locations, specific requirements are manda-
tory:

• a license installed on 4000 V2 Platform which will be accessible from any loca-
tions.

• an Ethernet connection (the Platform must have an IP address - see “Ethernet > 
Mode” on page 74) and, if the network uses a proxy, this proxy must be config-
ured (see “Proxy > Use proxy” on page 75).

• the Viavi application, downloaded for free at the address «http://smartac-
cess.updatemyunit.net».

• port 22 (SSH) or 443 (HTTS) output opened

• according to connection mode selected:

– the WIFI option installed on 4000 V2 Platform

– a USB cable to connect 4000 V2 Platform with Smartphone

– a Smartphone from given list and having appropriate basic subscription for 
internet connection sharing

Downloading the Viavi application on PC
The Viavi application Smart Access Anywhere must be downloaded on the PC which 
will be connected to the 4000 V2 Platform remotely.

Fig. 45 WIFI connection through Smartphone
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1 On PC, open an internet explorer and type the following address: http://
smartaccess.updatemyunit.net

2 Click on the link SmartAccessAnywhere_Vxx.xx.xx.zip 

3 Select Save in the dialog box.

4 Open the directory into which has been save the zip file and unzip files into a 
directory

5 Open the directory and double click on SmartAccessAnywhere.exe 

The Smart Access Anywhere application opens:

If the software version is not the last one available, a message displays, on the upper 
part of the screen to indicate the latest version available can be downloaded at the 
address: http://smartaccess.updatemyunit.net.

NOTE

It is not necessary to have administrator privileges to install the Viavi applica-
tion on PC. This application is just saved on PC.

Fig. 46 Smart Access Anywhere: Connection page
Enter Access Code
(see step 3 on page 84)
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Downloading the Viavi application on Tablet/
Smartphone
The Viavi application Smart Access Anywhere can be downloaded on a Smartphone 
or tablet which will be connected to the 4000 V2 Platform remotely.

1 On Smart device, open an internet explorer page and type the following address: 
http://smartaccess.updatemyunit.net

2 Click on the link SmartAccessAnywhere_Vxx.xx.xx.apk 

The downloading starts.

Some security messages can be displayed.

3 Follow the process on the Smart device to confirm the installation of the applica-
tion on the instrument.

4 Once the installation is completed, the icon appears on Tablet/Smartphone.

5 Click on the icon to launch the SmartAccess Anywhere application.

Launching the SmartAccess Anywhere application
Once connection is configured, the SmartAccess Anywhere application can be launched

On 4000 V2 Platform

1 On the Home page, select the SmartAccess icon 

As soon as the icon is selected, the 4000 V2 Platform begins to connect to Smart-
AccessAnywhere Server.

Fig. 47 Warning message of a new version available

NOTE

It is not necessary to have administrator privileges to install the Viavi applica-
tion. This application is just saved on the smartphone or tablet.
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2 Once connection is established with the server, the 4000 V2 Platform displays a 
message with the code to be used to access to the equipment remotely.

3 Note this access code and transfer it to the distant user, who will access the unit 
remotely.

4 Press OK to hide the message.

On the distant PC

1 On the PC of the distant user, once the application is launched, enter the Access 
Number on the upper part of the screen.

2 Click on Connect to validate 

The following screen displays:

Fig. 48 Access code displayed
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Using Remote screen and File Transfer applications
Once the Introduction page is displayed, the user can work on distant 4000 V2 Platform:

• transfer the interface to work on the unit (perform acquisition, configure the equip-
ment...)

• transfer files from the equipment toward the PC, and vice-versa.

Transferring the interface onto the PC/Smartphone/Tablet

To display the remote 4000 V2 Platform onto the PC:

1 On the Introduction page, click on .

or

On the left menu, click on 

The current screen of the 4000 V2 Platform displays:

Fig. 49 Smart Access Anywhere: Home page

Information on 
connection

After remote upgrade or reboot, please wait for more than 2 minutes 
before re-starting the link between the PC and the unit with SmartAcc-
essAnywhere.
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The VNC icon  on the upper banner of the unit indicates the remote screen 
is active.

2 On the upper part of the screen, the virtual control buttons bar is permanently 
displayed and allows to emulate hard keys.

You may click on any of these buttons to obtain exactly the same results than 
using the hard keys on the front panel of the 4000 V2 Platform.

3 You can use keyboard mouse of the PC to control the 4000 V2 Platform (see 
“Equivalence between the keyboard and 4000 V2 Platform” on page 101).

Transferring files

To work on files (onto PC and onto unit):

1 On the Introduction page, click on .

or

On the left menu, click on .

The file Explorer on PC and the one of the 4000 V2 Platform displays:

Fig. 50 Smart Access Anywhere: Remote screen
Virtual control buttons bar
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2 Double-click on one directory/storage media to display the contents (directories / 
sub-directories / files)

Navigation buttons

 

Transferring files from PC to 4000 V2 Platform

1 On the 4000 V2 Platform explorer, select the storage media, and if wished the 
(sub-)directory into which file will be transferred.

2 On the PC file explorer, select the file to be transferred

Fig. 51 File Transfer page

PC
Directories and files

4000 V2 Platform
Storage media available

Return to the Home directory

Select the PC drive in the list

Access to parent directory

click
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3 Click on the button Upload .

At the bottom of the screen, a new banner displays with information on file 
transfer:

Once transfer is completed, the banner disappears and the transferred file is underlined 
in blue on 4000 V2 Platform explorer.

Transferring files from 4000 V2 Platform to PC

1 On the PC explorer, select the storage media, and if wished the (sub-)directory 
into which file will be transferred.

2 On the file explorer of the 4000 V2 Platform, select the file to be transferred.

3 Click on the button Download .

A dialog box open, allowing to modify the location on PC of the file.

4 Select the directory into which file will be saved.

5 Press Save to start the transfer

Under both file explorers, a new banner displays with information on file transfer 
(see Figure 51 on page 87).

Once transfer is completed, the banner disappears and the transferred file is underlined 
in blue on PC explorer.

Fig. 52 Information on file transfer

1
2
3
4

1: location of the uploaded file on PC 3: level of transferred data

2: location of the file on 4000 V2 Plat-
form once transfer is completed

4: bar graph of the transfer in 
progress

Only one file can be uploaded from PC to 4000 V2 Platform at the same 
time.
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Working with files and directories on 4000 V2 
Platform

Renaming file or directory

1 Select a file/directory stored on the 4000 V2 Platform hard disk or USB key.

2 Click on .

3 In the new dialog box opened, enter a new name
for the file/directory, keeping the file extension.

4 Press OK to validate.

Deleting file

1 Select a file stored on the T-BERD/MTS-4000 V2 hard disk or USB key.

2 Click on .

3 In the new dialog box opened, press Yes to
confirm the deletion (or No to keep the file).

Creating a new directory

1 Select the storage and, if wished, the directory into which the new directory will be 
stored.

2 Click on .

3 In the new dialog box opened, enter a name for
the new directory (newdir is given by default).

4 Press OK to validate.

The new directory is automatically created at the
location selected.

Connection information and settings

Displaying session information

At any time during application use, the information about the session in progress can be 
displayed.

1 Press Session menu key on left of the screen .
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A screen as the following one displays:

This page gives information on connection «in real time».

Modifying connection settings 

To modify the settings for connection to internet:

1 Press Session menu key on left of the screen .

2 Disconnect from application pressing  

3 On the session screen (see Figure 53 on page 90), press button .

The following screen displays:

Fig. 53 Session page
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By default, the connection is defined to Smart-guess (default).

4 To modify the current parameters, select Forced settings.

The parameters for Port configurations turn automatically active.

5 Modify, if necessary, the port used: Default port (22) is selected by default

6 Select Alternative port (443) if necessary

7 If the parameter Alternative port (443) is selected, you can defined if the proxy is 
used or not in the following parameter.

The Internet proxy configuration is available exclusively if the port selected is 
Alternative port (443) and if the Proxy is selected.

8 Once configuration is completed, press .

The Home page displays (see Figure 49 on page 85).

Fig. 54 Connection settings

It is recommended to configure parameters of connection with your 
local network administrator, if the default parameters need to be modi-
fied.
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Testing connection

Before entering the Access code to activate the application, the connection to internet 
can be tested from displayed screen.

1 Open the Smart Access Anywhere application on PC

2 Press  button

The test is automatically launched

3 Press  to display logs in real time.

Once completed, the results for connection display:

The screen displays, in two different tables:

• the Upload and Download speed (in Kbyte/s) from Device to server.

• the Latency between Device and server (in ms).

1 Press  to delete the current table, and retest connection if wished.

2 If connection is valid, enter the access code and establish connection (see 
“Launching the SmartAccess Anywhere application” on page 83 - “On the distant 
PC” on page 84).

Fig. 55 Test results
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M2M Link option
If the option SmartAccess Anywhere is available on the Platform, the function M2M Link 
is also available .

This option allows to transfer data, perform OEO measurements or remote screen 
between two 4000 V2 Platforms using the Ethernet network.

Establishing connection between two 4000 V2 Platforms

To make two platforms  communicate via Ethernet, specific conditions and actions are 
required.

Before establishing the connection:

• An Internet connection must be established, with any kind of connection; 
Ethernet, WIFI...

• The distant Platform must be connected to Smart Access function (see 
“Launching the SmartAccess Anywhere application” on page 83).

• The SmartAccess code of the distant platform must be known by the operator on 
local one.

To establish the connection:

1 Validate the M2M Link icon on local Platform 

A numeric keypad automatically displays.

2 Enter the access code for the distant platform in the numeric keypad.

3 Press Enter to validate.

Fig. 56 Entering the Access Code



Chapter 7 Connectivity
Remote Control

94 User Manual 74000NG012 Rev. 000

Wait for the connection to be established.

Once connection is valid:

– a message displays on local Platform and on distant platform to confirm the 
connection.

– the M2M Link function turns active on distant Platform.

– the icon  displays on the upper banner, on each Platform.

Both platforms are ready to exchange data, perform OEO measurements or 
remote screen.

Remote screen function via M2M Link

This enables an operator at one end to take control over another 4000 V2 Platform 
connected at the other end, using the Ethernet network.

VNC configuration
Before it can be remote-controlled, the 4000 V2 Platform must be configured as 
explained in “Configuring the 4000 V2 Platform via Ethernet” on page 74.

Establishing communication
1 On the caller 4000 V2 Platform, press the HOME button, then select and confirm 

the M2M option:

– If the remote instrument is ready to receive (on standby), the M2M Link icon 
turns yellow, and the icon  appears at the top of the screen: data transfer, 
remote screen or oeo measurements can now take place. 

– If the remote instrument is not ready to receive, the M2M Link icon does not 
change color and a message is emitted.

2 Click next on Connectivity.

3 In the connectivity screen, click on Switch to remote screen.

Your screen is now fully replaced by the distant screen, and everything you do on 
your 4000 V2 Platform is in fact done on the distant 4000 V2 Platform.

An icon  appears in the top banner of the 4000 V2 Platform.

A slight normal color degradation may be seen on the 4000 V2 
Platform controlling a distant instrument.
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End of a VNC session
In order to end a VNC session, you can:

1 Return to the Connectivity page and click on Return to local screen. (Recom-
mended solution)

or

Deactivate the M2M Link function on either 4000 V2 Platform connected.

A dialog box displays, asking the confirmation of the disconnection.

Press Yes to stop the connection between the 2 Platforms.

Data Transfer between two Platforms

Once the connection is established between the 2 Platforms via M2M Link option, the 
files can be transfered from the master Platform to the slave one.

1 Open the File Explorer on the distant Platform

2 Select on the local disk or harddisk or USB key, the file(s) or directory to be 
imported in the local platform

3 Select the Slavedisk

4 Select if necessary a directory

5 Press Edit > Copy to copy the file(s)/directory on the Platform.

Data Transfer
The 4000 V2 Platform enables to transfer files, from or toward the product using Wifi, 
Bluetooth or Ethernet connection.

Transferring files via Bluetooth
Once the connection has been established with a bluetooth device:

1 On the Home page, press File Explorer key to go in the File Explorer.

2 Select the file(s) to be transferred from the Platform toward the PC.

NOTE

The VNC icon in the top banner of the screen lets you know at all times 
whether you are in a VNC session or not.
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3 Push Export > Send by Bluetooth menu keys .

A confirmation message displays once the transfer is completed.

You can also transfer file(s) from the bluetooth device toward the Platform.

In this case, the files received will be stored in a storage media created automatically on 
the Platform: bluetooth-inbox.

Transferring files to/from a PC via WIFI or Ethernet
Once connection is established between the Platform and the PC:

1 On the PC, use an FTP client, and access to internal memory via an internet 
explorer (I.E, Mozilla Firefox...) or Windows Explorer.

2 In the address bar, type the following address (10.33.22.68 being the IP 
address of the 4000 V2 Platform defined when the connection was configured):

ftp://mts4000:JDSU@10.33.22.68/disk/
This allows to access to internal memory.

Fig. 57 Confirmation of files sending

WARNING

The files stored in bluetooth-inbox will be lost once the 4000 V2 Plat-
form is switched off. Copy/Paste the files to keep toward another stor-
age media (disk, usb key...).
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ftp://mts4000:JDSU@10.33.22.68/usbflash/
This allows to access to the contents of the USB memory stick connected to the 
4000 V2 Platform.

3 If an identification is required, enter:

– User name: mts4000

– Password: JDSU

The PC then displays the contents of the internal memory or of the USB memory 
stick from the 4000 V2 Platform.

4 If internal memory of the Platform is accessible via Internet Explorer (or any other 
explorer), right click on one file and click on Save target as... to transfer file onto 
the PC.

If internal memory of the Platform is accessible via Windows Explorer, select one 
/ several files and click on Copy, then click on Paste on PC to transfer file(s).

If you use Internet Explorer 7, the following address must be entered:

ftp://mts4000:JDSU@10.33.22.68/acterna/user/disk or ftp://
mts4000:JDSU@10.33.22.68/acterna/user/usbflash

Fig. 58 Internal memory of the 4000 V2 Platform

Internal memory open via Internet Explorer Internal memory open via Windows Explorer
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Transferring files using Cloud Storage
Once connection between 4000 V2 Platform and cloud storage server is successfully 
established (see “Configuring and connecting to Cloud Storage on the 4000 V2 Platform” 
on page 77), the files can be transferred from one Platform to the other.

1 Press HOME hard key.

2 Press Explorer on the Home page

In the Explorer page, a new storage media is available: cloud-storage.

3 Transfer the files from the disk or USB memory stick of the 4000 V2 Platform 
toward the cloud storage or vice-versa:

a Select the file(s) to be transferred

b Press the Edit > Copy or Cut menu keys

c Select the storage media (and the directory) into which files must be copied.

d Press Paste menu key

The cloud-storage media is not available when File Explorer is opened 
from a FO application.

Fig. 59 File Explorer with cloud storage

Edition 
menu

The cloud storage is automatically disconnected once the 4000 V2 
Platform is switched off. Reconnect from the System Settings page of 
the 4000 V2 Platform after the Platform restart.
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VNC
The 4000 V2 Platform can be used in combination with a PC in order to transfer the Plat-
form Interface onto a PC, or to access the internal memory or USB memory stick 
contents on the PC.

The transfer of the interface can be done using a VNC window on PC.

Transferring the interface on a PC via WIFI or 
Ethernet
Once the connection is established between the 4000 V2 Platform and the PC, proceed 
as follow:

1 Open Internet Explorer on the PC.

2 First check the Export screen function is enable on the Platform:

a On the Home page, press Settings icon.

b In the System settings page, configure the Export screen function

Export screen = Session or Permanent must be confirmed in both cases, in the 
Interface E/S window.
– No: the screen cannot be remote on to a PC or on to another 4000 V2 Plat-

form.

– Session Mode: the Remote screen function is inactive once the 4000 V2 
Platform is switched off.

For an intensive use of the deport screen or when it is used via a WAN 
network, it is strongly recommended to use a dedicated VNC client. 
The VNC clients recommended are Tight VNC (V 1.2.9 or later) and Real 
VNC (V 4.1.1 or later).

Fig. 60 Export Screen configuration



Chapter 7 Connectivity
Remote Control

100 User Manual 74000NG012 Rev. 000

– Permanent Mode: the Remote screen function is still active when the 4000 
V2 Platform is switched off and restarted.

– Permanent with password
Same function as the Permanent mode, with an access to the equipment 
via VNC protected by a password: 42000

3 Considering 10.33.22.68 is the IP Address of the 4000 V2 Platform (as shown 
Figure 37 on page 72), enter the following address in the Internet Explorer 
window:

http://10.33.22.68:5800

4 Press Enter to validate.

The screen of the 4000 V2 Platform appears offset on your PC.

See “Virtual control buttons bar” on page 101 and “Equivalence between the keyboard 
and 4000 V2 Platform” on page 101 to get information on the deported screen use.

Fig. 61 VNC window

Click to install TightVNC 
software on your PC (not 
mandatory) 

NOTE

Once Remote screen is accessible via VNC, the icon  displays on the 
upper banner of the screen until the connection is cut or the 4000 V2 Plat-
form is switched off.
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Virtual control buttons bar
It is possible to emulate hard keys with Virtual Control buttons. This virtual control 
buttons bar is especially useful when the 4000 V2 Platform screen is exported on a 
remote PC.

To display those buttons, click once on the top of the screen in the status bar, at the same 
location as date and time.

The virtual control buttons bar is displayed during a few seconds. You may click on any 
of these buttons to obtain exactly the same results than using the hard keys on the front 
panel of the 4000 V2 Platform.

Equivalence between the keyboard and 4000 V2 
Platform
The PC keyboard can replaced all the buttons and keys of the 4000 V2 Platform except 
the ON/OFF button: 

• The menu keys to the right of the screen are replaced by the function keys F1 to 
F6.

• The buttons below the screen are equivalent to Ctrl + a letter (see table below).

• The direction keys have the same function on the external keyboard and on the 
4000 V2 Platform.

Function on the 4000 V2 Platform External keyboard 

HOME Ctrl + H

SET-UP Ctrl + U

FILE Ctrl + F

RESULTS Ctrl + R

START/STOP Ctrl + S

EXPORT Ctrl + Pa

←  ↑  →  ↓
Menu keys 1 to 6 (from top to bottom) F1 → F6

Validate a selection Entrée/Enter

Deslect a function on the Home page Escape/Echap.
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Stratasync

Principle and prerequisites of the Stratasync
Stratasync is a new solution that provides network operators with an agile and central-
ized way to manage and analyze data from thousands of deployed Viavi test instruments 
directly from the cloud.

StrataSync is a hosted, cloud-based software application that provides Viavi instrument 
asset, configuration, and test-date management.

StrataSync improves technician and instrument efficiency. 

StrataSync allows to: 

• Manages and tracks test instruments

• Collects and analyzes results from the entire network

• Informs and trains the workforce

a. The Export function is available exclusively on the virtual control buttons bar (see “Virtual 
control buttons bar” on page 101).

NOTE

Those equivalences are also valid with a keyboard directly connected to the 
4000 V2 Platform via one USB port.
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Pre-requisites for using the Stratasync with the 4000 V2 
Platform

The user must have subscribed to Stratasync, and by consequence, he must have 
acquired an account Identifier and a password.

The Ethernet and Proxy parameters must have been correctly configured in the System 
Settings page of the 4000 V2 Platform (see “Ethernet > Mode” on page 74 and “Proxy > 
Use proxy” on page 75).

Configuring and synchronizing the 4000 V2 Platform
The 4000 V2 Platform can be configured to be synchronized with the Stratasync.

1 On the Home page, press Connectivity.

2 Check the configuration of the Ethernet and Proxy parameters (see “Configuring 
the 4000 V2 Platform via Ethernet” on page 74

3 In the Connectivity windows, press Stratasync .

Fig. 62 Principle of the Stratasync application

Instruments are dialed in: 
the latest configurations 

and software

Techs are empowered: 
“right the first time” with 
the latest test instruction

Visibility throughout the 
entire network:  all results 

are immediately useful

Lots of data in

Simple 
data out
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4 Configure the Stratasync parameters:

a In the Server Type parameter, the Viavi Server is selected by default and it 
is recommended to keep this parameter.
However, the user can select if necessary the Server Name parameter and 
enter the name in the following parameter.

b In the Account ID parameter, enter the same identifier as the one used to 
access to Stratasync.

c The Technician ID parameter is automatically fulfilled after synchronization 
(if it has been defined by the administrator of the Stratasync)

d To upload the files from a directory onto the 4000 V2 Platform toward 
Stratasync, select the parameter Upload from and press right arrow key to 
enter the directory path (example: disk/Stratasync). The directory 
Stratasync is defined by default.

Connecting the 4000 V2 Platform to Stratasync
Once 4000 V2 Platform is configured in the Stratasync setup page:

1 In Home page, press Stratasync icon .

The synchronization with Stratasync starts

The icon  displays on the upper banner of the 4000 V2 Platform during 
synchronization.

Once the icon is no more displayed, this mean that the synchronization is 
completed.

Fig. 63 Stratasync configuration
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2 For the first synchronization only, a message displays on the 4000 V2 Platform to 
indicate the addition of the equipment in Stratasync.

The 4000 V2 Platform is now available in Stratasync.

Fig. 64 First synchronization - Message on 4000 V2 Platform
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Chapter 8Applications

Several desktop applications are provided to you, thanks to the integration of free soft-
ware released under the free licences (GPL, LGPL, BSB or other). Their purpose is to 
bring more functionality to the 4000 V2 Platform. Viavi doesn’t provide any warranty 
or support regarding these free software.

To access desktop applications, press the button HOME, and the soft key App’s.

The topics discussed in this chapter are as follows:

• "PDF Reader" page 108

• "Text Editor" page 109

• "Calculator" page 110

• "File Explorer" page 111



Chapter 8 Applications
PDF Reader

108 User Manual 74000NG012 Rev. 000

PDF Reader
The simplest way to open a pdf file is to press the Multi-views key and select File to open 
the Explorer.. Look for your file and then select Load >Confirm Load to load the corre-
sponding file. The file opens automatically in the PDF viewer.

Another way used to open a pdf document is to press Home > APPS and select the PDF 
Reader icon. 

The PDF Reader opens but without document. To open a PDF document, click on 
the icon , and select a document in the file explorer dialog box.

Interacting with a PDF document
Once your document is open, you may browse through different pages very quickly, 
zoom to a particular level, rotate the page... All these features are available via buttons 
on the screen. 

The buttons on the right are pressed using the functions keys of the 4000 V2 Platform, 
the touchscreen or via the mouse. The buttons on the bottom of the PDF viewer, may 
only be used with a mouse or a touchscreen.

Figure 65 PDF Viewer Graphical User Interface

Go to 10 pages less

Go to previous page

Go to next page

Rotate the page

Go to 10 pages more

Display the 
current page # Change zoom level Open file

Exit PDF viewer
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Text Editor
The Text Editor application allows to enter text on the 4000 V2 Platform and save it into 
a txt file

Text Editor page
To open the Text editor:

1 In the Home page, press the App’s key

2 In the Application screen, select the icon Text Editor.

The icon is framed in white

3 Press ENTER to validate the selection and open the Text Editor application.

Saving the text in a file
Once the text is entered, you can save it in a file onto the 4000 V2 Platform.

1 Click on File > Save or Save as...

2 In the new dialog box, select the folder in which the file must be saved

3 Enter a name for the file with the file extension (.txt or .csv if it must be opened 
with the 4000 V2 Platform).

Figure 66 Text Editor application
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4 Click on Ok to validate

The file is saved and still opened

– You can modify it and click on Save at any time

– If you modify the file and click on Save as....you can choose another folder and/
or another name

Press  to exit the text editor and go back to the Applications page.

Press HOME to go back to the Home page, and keep the application active (the icon  
is still displayed on the upper banner).

Calculator
A calculator can be displayed and used onto the 4000 V2 Platform.

1 In the Home page, press the App’s key

2 In the Application screen, select the icon Calculator.

The icon is framed in white

3 Press ENTER to validate the selection and open the Calculator

Figure 67 Save file

Select the folder

Enter file name

Save the file
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Press  to exit the Calculator and go back to the Application page.

Press HOME button to go back to the Home page, and keep the Calculator application 
active (the icon  is still displayed on the upper banner).

File Explorer
This key allows to directly open the MTS/T-BERD 4000 explorer, where all the files are 
stored (traces, pdf files...).

The explanation about the explorer are available in Chapter 9 “File management” on 
page 113.

Figure 68 Calculator
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Chapter 9File management

The files management with the 4000 V2 Platform can be performed, whether a module 
is set onto the 4000 V2 Platform or not.

The topics discussed in this chapter are as follows:

• “File Explorer Overview” on page 114

• “Directories and Files selections” on page 114

• “Directories & Files editing functions” on page 115

• “Working with directories / files from the explorer” on page 117

• “Creating a screenshot” on page 119

• “Merging pdf or txt files” on page 120

• “Storage media” on page 121
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File Explorer Overview
To reach the File Explorer page

• On the Home page, select the Explorer icon .

The File Explorer page appears.

Directories and Files selections

Directory selection
To select a directory from the explorer page:

1 Press on the directory that must be selected on the left of the screen.

The list of files the directory contains displays on the right side of the screen

The selected directory is underlined in blue

2 Click on the arrow at the left of the directory name, or press validation hard key 
 to display the sub-directories if any.

Figure 69 File Explorer page

Figure 70 Directory selection

Selected directory

Access to sub-directory
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Files selection
To select one or several files from the explorer page:

1 Press on files that must be selected.

or

To select a list of files using the keys of the Platform:

a Select and validate the first file of the list (underlined in red)

b Set the cursor on the last file of the list (underlined in blue)

c Maintain the right direction key  pushed until all the files are selected.

or

Click on Select all menu key to select all files into the directory.

Directories & Files editing functions
Copy/Cut & Paste files/directories

To copy (cut) one or several files, or one directory, and paste them in another place:

1 Select the directory / the file(s) (see “Directories and Files selections” on 
page 114).

NOTE

The last selected file is underlined in red and the previous one(s) selected is/
are underlined in blue. 

Figure 71 Example of files selection

Selected 
files

Selected 
directory
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2 Press Edit menu key

3 Press Copy to keep the directory / file(s) to their initial location.

or

Press Cut to delete the directory / file(s) from their initial location

4 On the left of the screen, select the directory; or select the new storage media.

5 Click on Paste menu key.

Renaming a directory / file
1 Select the directory / file to be renamed (see “Directories and Files selections” on 

page 114).

2 Press Edit > Rename Directory or Rename File.

The Edition keypad displays.

3 Press Clear if you wish to delete the entire name

4 Enter a new name for the directory / file.

5 Click on Enter to validate the new name.

Deleting a directory / file
1 Select the directory or file(s) to be deleted (see “Directories and Files selections” 

on page 114).

2 Press Edit > Delete.

A confirmation dialog box displays.

3 Press Yes to delete the selected directory or file(s).

Press No to cancel the deletion.

Figure 72 Edition keypad for renaming file
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Working with directories / files from the explorer

Creating a directory
To create a new directory from the explorer page:

1 Check the cursor is set on the left of the screen

2 Select the storage media into which the directory must be created

3 To create a sub-directory, select the directory into which it must be created.

4 Press the right menu key Create Directory.

The edition keypad displays

5 Enter a name for this directory

6 Press Enter key to validate the new directory

Opening files
Once a file is selected, press Load menu key.

File Types
For files recognized by the 4000 V2 Platform, the types are symbolized by icons. E.g.

Opening several files at the same time can be done exclusively with 
trace files (example: all OTDR trace files if a reference trace has been 
defined). Other type of files (PDF, TXT...) must be open one by one.

If different types of files have been selected in the Explorer, only the 
last one selected will open.

Icon Type of FO file

OTDR file (.SOR extension)

Multi OTDR file (.MSOR extension)

OSA file (.OSA extension)

Power Meter file (.LTS extension)
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Sorting files
Whether files are selected or not, the key Sort allows to access to a sub-menu allowing 
to sort the file according to pre-defined parameters:

• Sort by name: the files display in an ascending order (from A to Z). If you click 
once again on the key, the files display in a descending order (from Z to A).

• Sort by size: the files display from the smallest to the heaviest one. Clicking a 
second time allows to sort the files in opposite order.

• Sort by type: clicking once on this key; the 4000 V2 Platform displays files in an 
ascending order (the file type A to file type W). By clicking again, the 4000 V2 
Platform displays the files in opposite order.

• Sort by date: clicking once on this key; the 4000 V2 Platform displays files from 
the more recent to the less one. By clicking again on key, the Platform displays 
files from the older to the more recent one.

Icon Type of file

HTML file (.HTML extension)

PDF File (.PDF extension)

Text file (.TXT extension)

License file (.LIC extension)

CSV file (.CSV extension)

JPEG / JPG file (.JPEG extension)

PNG file (.PNG extension)

XML file (.XML extension)

With the 4000 V2 Platform, you can open and load any kind of FO files 
(OTDR, OSA,  LTS) even if the corresponding module is not set into the 
Platform.

NOTE

You can also sort files clicking on the column titles in the files list
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Creating a screenshot
You can create captures of the displayed screen, directly from the 4000 V2 Platform, in 
a pdf file.

Taking a screenshot
Once the screenshot parameters are configured:

1 Reach the display which will be saved as a screenshot in a file.

2 If necessary, make modifications on this display (example: zoom on trace...)

3 Click on the upper banner of the screen and, in the virtual control buttons bar, 
press Export key 

The icon  displays until the end of process.

4 Press the Multi-views key and select File to find the PDF file in the PDF reader.

For trace results, the file is saved in the same directory than the file used for 
screenshot, or in the last directory selected.

For other page open and used for a screenshot, the file is saved in the directory 
Print into the disk.

Name of the screenshots files
The screenshot is saved in a file, which is automatically named as follow: 

• Print_date (year/month/day)_time (hour/minute/second).jpg/png/pdf

Figure 73 Example of screenshot, open in the PDF Reader of the 4000 V2 Platform
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Merging pdf or txt files
In the Explorer page, two pdf or txt files or more, generated via the results traces can be 
merged in one pdf file.

• The pdf files that can be merged are those generated via the Fast Report key on 
trace results page or via the Export key on the upper banner (or left and right 
arrow keys) (see “Merging pdf or txt files” on page 120)

• The txt files that can be merged are those saved with the results trace (see OTDR 
Modules User Manual: E4100M02).

1 In the Explorer, select the two or more pdf or txt files generated

2 Press Export > Merge menu keys.

The icon  is displayed during merging process.

After a few seconds, the files are merged in one pdf/txt file, which name by default is: 
merged_year_month_date__hour_min_sec.pdf 

The file is automatically saved in the same directory as the one where files have been 
selected.
It gathers all results from pdf/txt files selected (and traces for pdf file), in one single pdf 
file of several pages (1 results screen per page, if the results table does not exceed one 
page).

Figure 74 Files selection and Merge key

NOTE

Once merged file is saved, it can be renamed in the Explorer (see “Renam-
ing a directory / file” on page 116).
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Storage media
For saving or recalling data, the 4000 V2 Platform offers a wide choice of media, both 
built-in and external.

Free space on selected media is clearly displayed at the bottom of the left panel.

Storage media built into the 4000 V2 Platform
The 4000 V2 Platform is delivered with an internal memory, which maximum capacity is 
of 8GB (with a minimum of about 1 Gb are available for data storage).

External USB storage media
The 4000 V2 Platform is equipped with 2 USB ports as standard. One of these can be 
used to connect an external storage medium, in particular a USB memory stick.

USB memory stick connection
1 Insert the USB memory stick in one of the 4000 V2 Platform's USB port. 

A sound is emitted to confirm the successful insertion and recognition of a USB 
memory stick.

Then, the icon  is displayed in the upper banner to inform the user the USB 
stick is ready to be used.

USB memory stick disconnection
1 Before disconnecting the USB memory stick, always select a storage device 

different from usbflash (select disk for example) in the explorer. 

NOTE

Although two USB ports are present, it is not possible to use simultaneously 
more than one external USB storage medium. 

When a file is moved in the explorer of the Platform, the end of the 
move on the screen does not mean that writing of data into the mem-
ory is complete. Some data may still be in a writing process if the stor-
age unit is removed prematurely.
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2 Make sure you no longer have any running applications using the usbflash 
storage media.

3 The user must push the EJECT USB key, available in File Explorer.

The icon becomes  to indicate it can be removed safely. In this state, the USB 
stick cannot be used anymore

The USB memory stick can then be disconnected from the Platform USB port.

See Chapter 12 “Maintenance & Troubleshooting” if any problem occurs with the USB 
memory stick

Abbreviations for storage media
The abbreviations used in the explorer for the different storage media are:

NOTE

The USB memory stick can also be removed using the Expert Tools > 
Media Utilities menu, accessible via the System Settings page.

Abbreviation Storage medium

disk Internal flash memory

usbflash USB memory stick

bluetooth-inbox Bluetooth storage media (option)a

a. The files stored in bluetooth-inbox are lost when the Platform is switched off.

cloud-storage Cloud storage media available on PC

slavedisk Slavedisk of the Platform connected to this one via 
M2M Link or Datalink
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Chapter 10Technical specifications

This chapter contains the technical specifications of the 4000 V2 Platform mainframe.

The topics discussed in this chapter are as follows:

• “Display” on page 124

• “Memory” on page 124

• “Input/Output” on page 124

• “Power supply” on page 124

• “Dimensions - Weight” on page 126

• “Environment” on page 127

• “Characteristics of the options” on page 129
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Display

Screen
• Backlight high visibility color screen

• Size: 9 inches 

• Resolution: 800 x 480 pixels

• High visibility capactitive touchscreen for indoor and outdoor use.

Memory
• Standard memory: internal memory, minimum capacity 8 Gb (with a minimum of 

about 1 Gb are available for data storage)

Input/Output
• two USB 2.0 Master ports, for scope, memory key, mouse, keyboard etc.

• one RJ 45 connector for Ethernet interface 10/100/1G

• headset (Jack Ø 2.5 mm)

Power supply

Battery
The instrument can be supplied with one Lithium Ion 6 cells (7400 mV) or 9 cells (11100 
mV) battery.

Battery charging time

If the battery is completely discharged, the time taken to recharge is:

Conditions of use
Charging time

6 cells battery 9 cells battery

The instrument is not in use (Charge indicator solid red) approximately 3 hours
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Endurance of the 4000 V2 Platform with battery

Measurement conditions:

- at +25 °C, 

- at full battery capacity (6.6 Ah), 

- 4000 V2 Platform equipped with one OTDR module

Endurance

Mains adapters

The instrument is used during charging (On indicator lit 
in fix green, Charge indicator lit in solid red)

about 5.5 hours about 9 hours

Conditions of use
Charging time

6 cells battery 9 cells battery

Endurance

Conditions of use
6 cells battery 
(7400 mV)

9 cells battery 
(11100 mV)

According to Telcordia GR-196-CORE recom-
mendation:
Normal conditons, with normal backlight, 3 
acquisition of 30 seconds per quarter of hour, 
auto off

up to 9 hours up to 16 hours.

Under continuous acquisition, with high screen 
backlight 

Up to 3h30 Up to 6h00

Standard Mains Adapter

Input 100-250 V, 50-60 Hz

Output 15V DC 3,7 A max
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Supply or Power assigned in AC and in DC: 35 W

Dimensions - Weight

Compliance EN 60950

Standard Mains Adapter

Weight

User interface module without options, battery nor module 1.1 kg 2.20 lbs

User interface module with a 6 cells battery, one OTDR LM Module 
and one dummy module

2.1 kg 4.40 lbs

OTDR LM Module 366 g 0.80 lbs

9 cells battery 490 g 1.08 lbs

6 cells battery 344 g 0.76 lbs

Dummy module 180 g 0.46 lbs

VFL/PWM option 26 g 0.06 lbs

Dimensions (mm)
( H X W X D )
Bumpers included

Dimensions (mm)
( H X W X D )
W/o bumpers

Without module 55.8 x 282 x 153 53.2 x 275 x 129

With 2 modules 92.4 x 282 x 153 85.8 x 275 x 129
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Environment

Temperature

Humidity
• 5 to 95% without condensation

Climatic pressure
Climatic pressure: 4000 meters

EMI/ESD
• CE class A Compliant (EN61326-1)

• FCC 47-1 Part 15 Compliant

Electrical Safety
• EN 61010-1: 2010 Compliant

Drop test
In accordance with the Telcordia GR-196-CORE recommendations, the 4000 V2 Plat-
form resists the following test: 

• 6 impacts dropped from a height of 0.75 m on a pinwood floor of 5 cm thickness 
(1 impact on each of its 6 sides, with power off).

• Operating temperature range
-20°C to +50°C
(-4°F to +122°F)

• Operation including all options 
(guaranteed specifications)

0° to +40°C
(+32°F to +104°F)

• Storage
-20°C to +60°C
(-4°F to +140°F)
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Shocks
The 4000 V2 Platform resists the following test:

• 3 shocks per axis along each of the 3 axes, with power off.

• Impacts of 15g, 1/2 sine, duration 11 ms, at 10 second intervals.

Bumps
The 4000 V2 Platform resists the following test: 

• 1,000 bumps per axis along each of the 3 axes, with power off.

• Jolts of 15g, 1/2 sine, duration 6 ms, at 1 second intervals.

Vibration
The 4000 V2 Platform resists the following vibration tests:

• Complete test comprising 6 cycles along each of the x, y and z axes.

• One cycle of 5 to 500 Hz and back to 5 Hz with a sweep duration of one minute/
octave.

• 3 mm amplitude displacement test, for the range 5 Hz to 22 Hz.

• 3g acceleration test for the range 23 Hz to 500 Hz.

Flammability
The housing of the 4000 V2 Platform (in ABS, type V0) does not propagate fire.

IP Protection Index
Index of the IP protection for the Platform 4000: IP32

NOTE

For a higher classification, contact Viavi.
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Characteristics of the options

Power meter option
Specifications given for 25°C, after 20 minutes stabilization time and after zero setting.

• Wavelength range: 800 to 1650 nm in steps of 1 nm

• Calibrated wavelengths: 850 / 1310 / 1490 / 1550 / 1625 / 1650 nm2

• Accuracy at calibrated wavelengths: ± 0.2 dB (at -30 dBm)

• Input power range : -60 dBm to +10 dBm

• Maximum resolution: 0.01 dB / 0.01nW

• Measurement range:+5 to -50 dBm (-45 dBm from 800 to 1250 nm)

• Linearity within the measurement range: ± 0.2 dB

Talkset option
• Dynamic range: typically 32 dB at 25°C with a FC adapter (use a FC/PC connec-

tion exclusively).

• Laser, typical wavelength 1625 nm, class 1 (EN60825 and FDA21 CFR Part 
1040.10)

VFL option
• Wavelength: 635 nm or 650 nm

• Length of fiber: up to 5 km

• Class 2 laser (standards EN60825-1 and FDA21 CFR Part 1040.10).

WIFI and Bluetooth Options
• WIFI:standard  IEEE802.11b/g/n

• Bluetooth Option

– Bluetooth V4.0

– Range: up to 10 meters

2.Specifications guaranteed to the calibrated wavelengths, except for 1650 nm
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Chapter 11Options and accessories

This chapter shows the references of the options and accessories of the 4000 V2 Plat-
form.

The topics discussed in this chapter are as follows:

• “References of options for the 4000 V2 Platform mainframe” on page 132

• “Reference of Scope” on page 134

• “References of accessories” on page 134

• “References of manuals” on page 134

• “References of result processing software” on page 135
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References of options for the 4000 V2 Platform 
mainframe3

3.These options must be ordered together with the instrument.

Base Unit references References

MTS-4000 V2 Platform, with High visibility Touchscreena EM4000HVT

T-BERD 4000 V2 Platform, with High visibility Touchscreena ETB4000HVT

a. Delivered with a battery (to be configured) and AC/DC Supply (to be configured)

Power Meter / VFL / Talkset options References

Optical Power Meter with 2.5 mm UPP connector E40PM

Talk set option with power meter E40TSPM

VFL with UPP connector E40VFL

Optical Power Meter and VFL, with 2.5 mm UPP connectors E40PMVFL

WIFI/Bluetooth option Reference

Wifi/Bluetooth Built-in option E40WIFIBLU2

Battery options Reference

Additional Li-Ion rechargeable battery ELIION9C

Mains options References

Additional standard AC/DC adapter/charger (USA) E40PWUS

Additional standard AC/DC adapter/charger (UK) E40PWUK

Additional standard AC/DC adapter/charger (Europe) E40PWE

Additional standard AC/DC adapter/charger (Australia) E40PWAU

Additional standard AC/DC adapter/charger (Switzerland) E40PWCH

Additional standard AC/DC adapter/charger (India/South Africa) E40PWIN

Additional standard AC/DC adapter/charger (Italy) E40PWIT

Additional standard AC/DC adapter/charger (Israel) E40PWIL
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Additional standard AC/DC adapter/charger (Japan) E40PWJP

Additional standard AC/DC adapter/charger (Denmark) E40PWDK

Cigarette lighter adapter for 4000 V2 Platform E40Lighter

Mains options References

Smart Access Anywhere Reference

Smart Access Anywhere for 4000 V2 Platform -L2: Remote 
coaching and file transfer for T-BERD/MTS 4000 using Ethernet, 
WIFI and selected Smartphone (via USB or WIFI)

SAA-L2

SmartFTTA (Software license) Reference

FTTA-SLM OTDR function for T-BERD/MTS-4000 V2 EFTTASLM

FTTH SLM (Software license) References

FTTH-SLM OTDR option for T-BERD/MTS-4000 V2 EFTTHSLM

Enterprise-SLM (Software license) Reference

Enterprise-SLM OTDR option for T-BERD/MTS-4000 V2 ENTERPRISESLM

SmartAcq OTDR Option (Software license) Reference

Smart Acquisition OTDR option for T-BERD/MTS-4000 V2 ESMARTACQ

Cable-SLM (Software license) Reference

Cable-SLM OTDR option for T-BERD/MTS-4000 V2 ECABLESLM
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Reference of Scope

References of accessories

References of manuals

Scope P5000i Reference

Digital Videoscope kit including FBP-P5000i probe (USB2.0) in a small 
soft case, and 7 tips in a box (FC, SC, SC-APC, LC, U25M, U25MA & 
U12M)

EDFSCOPE5KI

Carrying Cases References

Soft case for small MTS/T-BERD 4000 V2 modules E40SMODSCASE1

Hard carrying case for the MTS/T-BERD 4000 V2 EHCASE6

Hard carrying case for two T-BERD/MTS-4000 V2 Platforms EHCASE4X2

Glove Soft Case for MTS/T-BERD 4000 V2 Platform E40GLOVE

Wrap-around Soft Case for MTS/T-BERD 4000 V2 Platform E40SCASE1

Keyboard/Mouse References

USB mouse E80mouse

USB QWERTY keyboard E80keyB

User manual for 4000 V2 Platform References

Printed User manual for 4000 V2 Platform (French) E4000V2M01

Printed User manual for 4000 V2 Platform (English) E4000V2M02

Printed User manual for 4000 V2 Platform (German) E4000V2M03
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References of result processing software4

NOTE

The User Manuals for MTS/T-BERD 4000 V2 (Platform & Modules) are avail-
able in pdf format, into the unit.

The printed versions of the manuals are available on option, in French, 
English and German.

4.Free software updates on the Web (but without user manual)

fFiber Cable / Fiber Trace References

Optical Fiber Trace software EOFS100

Optical Fiber Trace software (5 licences) EOFS1005L

Optical Fiber Trace software (site licence) EOFS100SL

Optical Fiber Cable software EOFS200

Optical Fiber Cable software (5 licences) EOFS2005L

Optical Fiber Cable software (site licence) EOFS200SL
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Chapter 12Maintenance & Troubleshooting

This chapter describes how to maintain your unit and identify and correct problems 
related to the 4000 V2 Platform.

The topics discussed in this chapter are as follows:

• “Maintenance procedure” on page 138

• “Recycling Information” on page 152

• “Troubleshooting” on page 153

• “General information on warranty” on page 156
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Maintenance procedure

Maintenance work on this instrument must only be undertaken by qualified 
personnel using suitable equipment.

In most cases, it is advisable to contact the nearest Viavi Service Centre, which will 
undertake the appropriate troubleshooting and repair work.
The performance and technical complexity of the 4000 V2 Platform class this instrument 
in a new generation of equipment, for which Viavi has laid down a maintenance policy 
based on the principle of standard module replacement.
In implementation of this policy, we have set up powerful card troubleshooting test 
resources in our factories and a rapid dispatch system operating between our factories 
and branches.
Only by this procedure can the high quality of the instrument continue to be ensured after 
repair work. This procedure also has the advantage of reducing repair costs and time.

In the interests of quality and efficiency, we strongly recommend adoption of the 
following procedure in the event of a fault, before any other steps are taken:

• Verify that the instrument is plugged in.

• Check the connections of any peripheral equipment to the Platform.

• If a fault is detected, or in case of doubt, it is advisable to contact the nearest 
Viavi Service Centre, which will undertake the appropriate repair work. 

Cleaning

Cleaning plates and housings
The front and rear plates and the housings may become tarnished with handling. To 
clean them, use only a rag moistened with soapy water.

Never use any product containing acetone, trichlorethylene, benzine or alcohol, as these 
will attack the printed markings.

Cleaning the screen
To clean the screen, use an antistatic product.
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Cleaning the optical cable connector
• Use a non-fluffy type of paper, such as Joseph paper, soaked in isopropylic 

alcohol.

• Pay particular attention to the polished face of the fiber, rubbing it in a direction 
perpendicular to the axis of the fiber.

Cleaning the optical connections of the 4000 V2 
Platform
• Squirt a highly volatile solvent (such as isopropylic alcohol) into the connector.

• Blow out the connector using a clean dry air supply from an aerosol can fitted with 
an extension.

Accessing to the 4000 V2 Platform information 
On the 4000 V2 Platform, some screens allows to display information on different 
elements of the equipment.

To display the information on the 4000 V2 Platform

1 On the Home page, validate Settings icon to reach the System Settings page.

2 On the right menu keys, press About to display the presentation screen of the 
4000 V2 Platform.

General page
The General page is displayed by default, and allows to display the presentation screen, 
with all the information concerning the software versions, the hardware options and the 
module installed.

NOTE

If your module has a universal connector, unscrew its adaptor to access the 
ferule.
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This page shows:

• The software version information

• The product contents: base, optical options, battery type, touchscreen used, 
module installed and date of calibration for options.

The options set into the 4000 V2 Platform are marked with a green tick.

Software options page
This page allows to visualize the software options available on the 4000 V2 Platform.

1 Once on the About screen, press Software Options menu key to display the list 
of software options available on your 4000 V2 Platform.

Fig. 75 General page

Fig. 76 Software Options page
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Services Data page
This page allows to display information about the elements inside the 4000 V2 Platform 
(CPU, Memory, hardware revision, screen reference...).

1 Once on the About screen, press Services Data menu key to display the list of 
elements contained on your 4000 V2 Platform.

Accessing to the 4000 V2 Platform documentation
All documents necessary for the 4000 V2 Platform use are directly available onto the 
equipment.

To display the list of documents available for 4000 V2 Platform use:

1 Validate the Help icon  on the Home page.

2 In the page, click one link to display the corresponding document: User manual, 
Getting Started Manual, Quick Card...

Fig. 77 Services Data page
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Installing a new version of the software

Downloading from Internet
When the software is obtained from the Internet, it must be saved on a storage medium 
before the software upgrade of the product can be carried out. To do this:

1 Open Internet Explorer

2 Enter the internet address  http://www.updatemyunit.net, which will give 
access to the installation portals for all T-BERD/MTS from VIAVI.

3 Click on the link T-BERD®/MTS-4000V2 Platform.

Fig. 78 Help page

When a new software version is loaded, there is a risk of re-initialization of 
the internal memory. Before installing the new software, it is therefore advis-
able to save the results in the memory, using the Save function called up by 
the Multi-views > File button.

Do not interrupt the installation process, as this could damage the instru-
ment.

To avoid any interruption of the installation procedure, the 4000 V2 Platform 
must be operating on the mains: if the procedure is started while operating 
on battery, a message indicates that the instrument must be connected to 
the mains.
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A new page opens, displaying the current version available

4 According to your region, click on the one of the following icon to download the 
archive.

Download from European server

Download from North American server

Download from Singapore server

5 In the new dialog box displayed, click on Save to save the exe file on the PC.

6 Once completed, connect the USB memory stick to the PC and follow the instruc-
tions chapter “Installation from a USB memory stick” on page 145, from step 2.

Installation from Viavi Server
The update can be performed directly onto the equipment, using the Viavi server.

1 Connect the 4000 V2 Platform to a PC via an Ethernet cable or via WIFI.

2 Check on the Ethernet or WIFI setup page that the connection mode is defined to 
Automatic (Home > Connectivity > Ethernet/WIFI > Mode: Dynamic).

3 On the Home page, press Connectivity icon .

4 Press Upgrade icon .

5 In the Upgrade Server box:

– On the line Address Type, select Viavi Server

The address 4kv2.updatemyunit.net is automatically displayed.

6 Select if the new release for 4000 V2 Platform must be automatically detected 
(Enable) or not (Disable). See “Checking new upgrade on Viavi Server” on 
page 147.

7 Press Software Upgrade > Upgrade via Ethernet.
The message Verify IP address of PC server appears. 

8 Click on Continue.

Fig. 79 Configuration of the Viavi Server
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The list of the software versions available on the PC is displayed next to the 
versions installed on the 4000 V2 Platform.

Installation from another server
Before starting the software upgrade via Ethernet, make sure the IP address of the PC 
server.

The update can be performed directly onto the equipment, using an http address.

1 Connect the 4000 V2 Platform to a PC via an Ethernet link or via WIFI.

2 Check on the Ethernet or WIFI setup page that the connection mode is defined to 
Automatic (Home > Connectivity > Ethernet / WIFI > Mode: Dynamic).

3 On the Home page, press Connectivity icon .

4 Press Upgrade icon .

5 In the Upgrade Server box:

– On the line Address Type, select Server Name or IP Address.

– Enter the Server Name (if Server Name has been previously selected) or the 
Server Address (if IP Address has been previously selected)

6 Press Software Upgrade > Upgrade via Ethernet.
The message Verify IP address of PC server appears. 

7 Click on Continue. 
The list of the software versions available on the PC is displayed next to the 
versions installed on the 4000 V2 Platform (see Figure 80 on page 144).

Fig. 80 List of software versions (current and new)

Software versions installed 
on Platform

Software versions 
available on selected 
media for update
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Installation from a USB memory stick
You must be equipped with a USB memory stick with a minimum capacity of 128 Mo.

Before installing the upgrade, you must format the USB memory stick (see “Formatting 
the USB memory stick onto the 4000 V2 Platform” on page 154).

1 Once formatted, disconnect the USB memory stick from the 4000 V2 Platform 
using the key Eject USB in the Media Utilities page.

2 Connect the USB memory stick to the PC

3 Unzip the upgrade files on the PC and transfer it to the USB memory stick:

a Download and save on your PC the.exe upgrade file that you can get from 
the web (see “Downloading from Internet” on page 142). 

b Once the transfer is completed, double click on the.exe file: A window will 
appear. Check that the folder is correct i.e. the USB memory stick driver is 
appearing in the line at the bottom of the dialog box then press OK. If not, 
click on the icon  in order to select the right USB drive.

c Press OK and wait for the end of loading.

4 Then remove the USB memory stick, using the appropriate procedure, from your 
PC

5 Insert the memory stick into one of the USB ports on the Platform.

As for any media formatting, please note that all data present on the USB 
memory stick will be irremediably lost.

Fig. 81 List of software update
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6 On the Home page, press Connectivity icon .

7 Press Upgrade icon .

8 Press Software Upgrade > Upgrade from USB..
The message Are you sure? is displayed

9 Click on Confirm. 

The list of the software versions available on the USB stick is displayed next to 
the versions installed on the 4000 V2 Platform (see Figure 80 on page 144).

Launching the upgrade
Whatever is the method selected for upgrade (Server, USB key...) and once the list of 
the software versions available is displayed next to the versions installed on the 4000 V2 
Platform (see Figure 80 on page 144), follow these instructions to launch the upgrade:

1 Click on Show Prev choice or Show Next Choice to display the previous and 
next versions available.

2 Click on Confirm this Choice to start the upgrade of the selected software(s). 

or
Click on Confirm All Choices to upgrade all versions.

Upgrading begins. The 4000 V2 Platform is automatically rebooted. Upgrading 
takes several minutes. Finally, the 4000 V2 Platform is automatically restarted.

NOTE

A bip is emitted each time the USB memory stick is inserted or removed from 
the USB port.

NOTE

The software versions list does not always appear (cf previous versions) as 
well as the Previous / Next Choice buttons and the Confirm/Continue key. 
In this case, the upgrading starts automatically.
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Checking new upgrade on Viavi Server
If the Viavi Server is selected for upgrade (see Figure 79 on page 143), the parameter 
Check new release can be defined to automatically inform user of a new upgrade avail-
able for Platform.

1 In the Connectivity screen, select Upgrade icon.

2 Check the Address Type is set to Viavi Server.

3 Define the parameter Check new release to Enable.

If the parameter is set to Enable, a message displays, at any time, when one 
update is available on server.

4 Press Ok to display the list of software versions available (see Figure 80 on 
page 144) and follow instructions “Launching the upgrade” on page 146.

Install Software License
This page allows to import the license to get a software option.

During the upgrade, the Testing indicator is lit in red. Do not push any 
button or remove the USB memory stick while the indicator is lit. The 
USB stick can be removed if necessary once the Testing indicator is 
off.

Fig. 82 Checking new release
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To import the license, you can either enter manually the license code, given in the 
license file, (.lic file) or import this file with a USB memory stick connected to the 4000 
V2 Platform.

Enter Manually the License
1 In the Home page, click on Settings icon.

2 Click on Expert Tools > Install Option > Enter Challenge

The edition keypad is displayed

3 Enter the challenge code of the option, set at the bottom of the file (see Figure 83 
on page 148).

Fig. 83 Example of a License file (.lic)

License Code

It is strongly recommended to perform the installation using the impor-
tation of License via a USB memory stick.
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4 Press the Enter key to validate the code

Your software options will be installed

At the end of this sequence you will be asked to reboot the unit to apply the modi-
fications, pushing the Reboot key. Confirm the reboot to restart the Platform.

Import the license from the USB memory stick

1 In the Home page, select the Settings icon

2 In the System Settings page, press Expert Tools >  Install Option > Import 
License.

If the USB memory stick is not already connected to the Platform, a message 
asking the memory stick insertion is displayed. Confirm it once the stick is 
connected.

3 In the File Explorer, select the USB stick, then the license file (.lic) to be imported,

Fig. 84 Enter the License code

The license file can be opened via a word processing software such as 
Word...

The challenge code must be entered exactly as it is in the .lic file, pay-
ing attention to the lower-case and upper-case letters etc.

CAUTION

Any file linked to the license file (.lic) must be saved at the root of the USB 
key.
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4 Click on Load > Confirm

5 The challenge codes contained in this file will then be loaded automatically and 
your software options will be installed.

6 At the end of this sequence you will be asked to reboot the unit to apply the modi-
fications, pushing the Reboot key . 

7 Confirm the reboot 

Locking the 4000 V2 Platform
The 4000 V2 Platform can be locked at any time:

1 In the HOME page, click on Settings icon to open the System Settings page.

2 Click on Expert Tools > Instrument Lock

3 Confirm the 4000 V2 Platform locking by clicking on Confirm (or use the Cancel 
key to cancel the process).

The numeric keypad is displayed

4 Enter the password to lock the instrument: 42000 with the numeric keypad 
displayed.

Fig. 85 License imported
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5 Click on Enter

The 4000 V2 Platform locking screen is displayed.

Click on the Notepad Message key to add a message using the text edition.

Unlocking the 4000 V2 Platform

1 Once the locking screen is displayed, click on the key Unlock Instrument.

2 Press confirm to confirm the Platform must be unlocked.

3 Enter the password 42000 using the numeric keypad displayed and validate.

Fig. 86 Password

Fig. 87 Locking screen
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The screen automatically displays the HOME page.

Returning an instrument
When returning an instrument, it is essential to indicate the following minimum informa-
tion:

• the type and serial number of the instrument (on the identification label) and the 
configuration code (under the bar code)

• a description of the fault found on the instrument.

The returned instrument will then be repaired and calibrated.

Guarantee conditions
Any repair operation supervening within the guarantee period of the instrument will be 
carried out at the expense of Viavi. However, for any sub-assembly upon which work has 
been carried out otherwise than by Viavi Service Centers, the cost of a replacement sub-
assembly will be invoiced.

Recycling Information
Viavi recommends that customers dispose of their instruments and peripherals in an 
environmentally sound manner. Potential methods include reuse of parts or whole prod-
ucts and recycling of products components, and/or materials.

Waste Electrical and electronic Equipment (WEEE) 
Directive

In the European Union, this label indicates that this product should not be 
disposed of with household waste. Il should be deposited at an appropriate 
facility to enable recovery and recycling.
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Troubleshooting

Interpreting alarms

Troubleshooting Solution

Nothing happens when the ON/
OFF key is pressed.

- Make sure that the battery is present or charged; or 
the mains adapter is properly connected (see “Con-
necting the mains adapter” on page 16).

Nothing happens on screen, what-
ever is the action done (menu key 
or hard key pressed...)

- The Platform must be rebooted.
See “Resetting the 4000 V2 Platform” on page 19.

You are using the 4000 V2 Plat-
form in the ordinary way when it 
suddenly switches off.

- Check the instrument is not configured to Auto off. 
See “Defining the Automatic shutdown of the 4000 V2 
Platform” on page 24). 
- Check the battery charge level. See “Charging the 
battery” on page 16.

The battery refuses to charge (the 
Charge indicator does not go on 
when the instrument is connected 
to the mains and is not operating).

- There is no battery in the instrument.
- The temperature level of the equipment does not 
allow the battery charging for safety reasons. Wait the 
equipment cools down.
- The battery needs to be changed.
See “Changing the battery” on page 154.

Error message when USB has 
been disconnected

- The USB disconnection has not been done properly 
(see “USB memory stick disconnection” on page 121)
- The data transfer was not completed when USB key 
was disconnected.

No beep is emitted when the USB 
memory stick is connected

- A previous USB memory stick has not been properly 
disconnected (see page 121).
- The USB memory stick is not detected by the 4000 V2 
Platform: use another memory stick, or another storage 
media.

Error message when upgrade via 
Ethernet is confirmed

- Check the Server Name is correctly entered (see 
“Installation from another server” on page 144)

Error message when upgrade via 
USB key is confirmed

Check the USB key is correctly connected (see “USB 
memory stick connection” on page 121)

Error message when unlocking the 
instrument

- The password is not the correct one (see “Locking the 
4000 V2 Platform” on page 150).
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Formatting the USB memory stick onto the 4000 V2 
Platform

If the USB icon  is displayed on the upper banner of the screen, when a USB 
memory stick is connected to the 4000 V2 Platform, this may means the memory stick 
must be formatted.

If the stick needs to be formatted, proceed as follows:

1 Insert the memory stick into one of the USB port on the top of the 4000 V2 Plat-
form.

2 Press the HOME button

3 Validate the Settings icon to open the System Settings page.

4 On the right menu keys, successively select Expert tools > Media utilities > 
Usbflash Format.

5 Confirm your choice to actually format the USB memory stick.

Erase disk
To delete all the disk contents of the 4000 V2 Platform:

1 On the Home page, Press twice the Settings icon to open the System Settings 
page

2 Press Expert Tools > Media Utilities, 

3 Select Erase Disk to delete all the disk contents into the 4000 V2 Platform.

A confirmation must be validated before the deletion.

Changing the battery
If you meet problems during the Platform functioning, or if the battery does not charge 
anymore when plugged, this may require the battery to be replaced.

As for any media formatting, please note that all data present on the 
USB memory stick will be irremediably lost.
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Accessing to the damaged battery
1 Switch off the instrument and disconnect the mains supply.

2 On the left side of the equipement, loosen the captive screws (a) at both sides 
using a Philips head screwdriver.

3 Remove the battery door, pulling with the help of the screws

4 Pull the battery to disconnect it from the base, taking care not to damage the 
connector into which it is plugged.

Installing a new battery
1 Switch off the instrument and disconnect the mains supply.

2 On the left side of the equipment, loosen the captive screws (a) at both sides 
using a Philips head screwdriver.

3 Remove the battery door, pulling with the help of the screws.

CAUTION

Battery is not interchangeable in the field. It must be replaced exclu-
sively for maintenance purpose.

Figure 88 Battery seatings

 screws (a) Battery

Date and Time parameters will be lost when battery is disconnected.
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4 Push the battery to connect it to the base, taking care not to damage the 
connector into which it is plugged.

5 Set back the battery door and tighten the captive screws at both sides.

Contact Viavi local Sales Service to get a new battery.

General information on warranty
The warranties described herein shall apply to all commercially available Viavi products. 
Any additional or different warranties shall apply only if agreed to by Viavi in writing. 
These warranties are not transferable without the express written consent of Viavi. 

Hardware Warranty
Viavi warrants that Hardware Product sold to customer shall, under normal use and 
service, be free from defects in materials and workmanship. Information regarding the 
specific warranty period for this product can be obtained by contacting your local Viavi 
Customer Service Representative, or at our web site www.viavisolutions.com. If 
installation services have been ordered, the warranty period shall begin on the earlier of 
(1) completion of installation, or (2) thirty (30) days after shipment to customer. If Instal-
lation Services have not been ordered, the warranty period shall begin upon shipment 
to Customer. Hereafter these periods of time shall be collectively referred to as the Initial 
Warranty Period.

Viavi ’s obligation and customer’s sole remedy under this Hardware Warranty is limited 
to the repair or replacement, at Viavi’s option, of the defective product. Viavi shall have 
no obligation to remedy any such defect if it can be shown: (a) that the Product was 
altered, repaired, or reworked by any party other than Viavi without Viavi’s written 
consent; (b) that such defects were the result of customer’s improper storage, mishan-
dling, abuse, or misuse of Product; (c) that such defects were the result of customer’s 
use of Product in conjunction with equipment electronically or mechanically incompatible 

When putting a battery back into its seating, make sure that its con-
nector engages correctly with the one of the base and that the door is 
correctly closed.

Do not use any battery other than the one supplied with the instru-
ment, or supplied by Viavi.
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or of an inferior quality; or (d) that the defect was the result of damage by fire, explosion, 
power failure, or any act of nature.

Viavi performed repairs shall be warranted from defective material and workmanship for 
a period of ninety (90) days, or until the end of the Initial Warranty Period, whichever is 
longer. Risk of loss or damage to Product returned to Viavi for repair or replacement shall 
be borne by customer until delivery to Viavi.

Upon delivery of such product, Viavi shall assume the risk of loss or damage until that 
time that the product being repaired or replaced is returned and delivered to customer. 
Customer shall pay all transportation costs for equipment or software shipped to Viavi 
for repair or replacement. Viavi shall pay all transportation costs associated with 
returning repaired or replaced product to customer.

Warranty disclaimer
For hardware and/or services furnished by Viavi, the foregoing warranties are in lieu of 
all other warrantees and conditions, express or implied. Viavi specifically disclaims all 
other warranties, either express or implied, on any hardware, documentation or services 
including but not limited to warranties relating to quality, performance, noninfringement, 
merchantability or fitness for a particular purpose, as well as those arising from any 
course of dealing, usage or trade practice. under no circumstances will Viavi be liable for 
any indirect or consequential damages related to breach of this warranty.
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